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Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©January 2019

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, L ux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia

ErP Off Mode Power Consumption Statement:
Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode:

« Off Mode <0.5W
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

SN
PR

Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the

equipment.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit:

Full Range AC/DC Adapter — AC in 100 - 240V, 50 - 60Hz DC Output 19.5V, 6.15A (120 Watts) minimum

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1.

2.
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Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

Do not placeit on an unstable
surface.

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place where
foreign matter or moisture may
affect the system.

Don't use or store the computer
in a humid environment.

Do not place the computer on
any surface that will block the
\ents/Fan Intakes.

Vi
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other

strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power until
you properly shut down all pro-
grams.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your compulter.

-

5. Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.

VIiI



Preface

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and may expose you and
the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from
the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

»  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

* If the computer does not work normally when you follow the operating instructions.

* If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
* If thereisan unusua odor, heat or smoke coming from your computer.

\ A/
LS
Bottom Cover Removal Warning

Users should not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may violate the terms of
your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your dis-
tributor/supplier for further information.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and

screw(s) before restoring power to the system.
Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.
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Power Safety

The computer has specific power requirements:

\ A/
2R
Power Safety Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines and power
cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine on.
Before removing the
battery disconnect the
AC/DC adapter from
the computer.

Only use a power adapter approved for use with this computer.

Your AC/DC adapter may be designed for international travel but it till requires a
steady, uninterrupted power supply. If you are unsure of your local power specifica
tions, consult your service representative or local power company.

The power adapter may have either a 2-prong or a 3-prong grounded plug. The third
prong is an important safety feature; do not defeat its purpose. If you do not have access
to acompatible outlet, have aqudified electrician install one.

When you want to unplug the power cord, be sure to disconnect it by the plug head, not
by itswire.

Make sure the socket and any extension cord(s) you use can support the total current
load of all the connected devices.

Before cleaning the computer, make sure it is disconnected from any external power
supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power Do not use the power cordif | Do not place heavy objects
cord if you are wet. itis broken. on the power cord.
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Polymer/Lithium-lon Battery Precautions
Note the following information which is specific to Polymer/Lithium-lon batteries only, and where applicable,
this overrides the general battery precaution information overleaf.

» Polymer/Lithium-lon batteries may experience a dight expansion or swelling, however thisis part of the battery’s
safety mechanism and is not a cause for concern.

e Use proper handling procedures when using Polymer/Lithium-1on batteries. Do not use Polymer/Lithium-lon batteries
in high ambient temperature environments, and do not store unused batteries for extended periods.

» If you are working in areas of low temperature use the AC/DC adapter to power the computer.

See aso the general battery precautionary information overleaf for further information.

Xl
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General Battery Precautions

» Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

» Do not remove any batteries from the computer while it is powered on.

» Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

» If you do not use the battery for an extended period, then remove the battery from the computer for storage.

» Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

» Donot try to repair abattery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

» Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

» Do not touch the battery contacts with your hands or metal objects.

\ A/
2R
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.

Xl
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Cleaning Instructions

(For Computer Models Supplied with Light Blue Cleaning Cloth)
Some computer modelsin this series come supplied with alight blue cleaning cloth. To clean the computer case
with this cloth follow the instructions below:

Power off the computer and peripherals.

Disconnect the AC/DC adapter from the computer.

Use a little water to dampen the cloth slightly.

Clean the computer case with the cloth.

Dry the computer with a dry cloth, or allow it time to dry before turning on.
Reconnect the AC/DC adapter and turn the computer on.

ok wnpE

X1l
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Travel Considerations
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-
ware and software. Make sure your “papers” are handy.

SN
L&

Power Off Before Traveling

agprwbNPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.

XV
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

» Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

» Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
afootrest if necessary.

» Useachair with aback and adjust it to support your lower back comfortably.

o Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

» Take periodic breaks if you are using the computer for long periods of time.

Remember to:

« Alter your posture frequently.

» Stretch and exercise your body several times aday.

» Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

XVI
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Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plans to turn the screen off after a few minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may devel op sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.

XVII
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

» Chapter 2

e Chapter 3
e Chapter 4

e Chapter 5
» Chapter 6

e Chapter 7
« Appendix A

* Appendix B
* Appendix C
e Appendix D

A guide to using some of the main features of the computer e.g. the stor age devices (hard disk and
card reader), TouchPad & M ouse and Audio Features.

The computer’s power management options.

Theinstallation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

An outline of the computer’s built-in software or BIOS (Basic Input Output System).

A quick guide to the computer’s PC Camera, WirelessL AN, Bluetooth & WLAN Combo,
Sound Blaster Audio and Intel modules (some of which may be optional depending on your pur-
chase configuration).

A troubleshooting guide.

Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

Information on the Control Center.

Information on the Video driver controls.

The computer’s specification.

Overview 1 -1
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “Drivers & Utilities” on page4 - 1 and “BIOS Utilities’ on page5 - 1 in the User’'s Manual. You
may also find the notes marked with a /# of interest to you.

Beginners and Not-So-Advanced Users
4 If you are new to computers (or do not have an advanced knowledge of them) then
Notes the information contained in this Quick Start Guide should be enough to get you up
. and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark '
above to find detailed remainder of the User’s Manual), but do not worry if you do not understand every-
information about the || thing the first time. Keep this manual nearby and refer to it to learn as you go. You
computer’s features. may find it useful to refer to the notes marked with a .~ as indicated in the margin.
For amore detailed description of any of the interface ports and jacks see “ I nterface
(Ports & Jacks)” on pageA - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Not Included

Operating Systems (e.g. Windows 10) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.

1-2 Overview
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4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4

- 4. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn'’t been properly configured (your service representative may have already done that for you), refer to “ Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.

System Software

Y our computer may already come with system software pre-installed. Where thisis not the case, or where you
arere-configuring your computer for adifferent system, you will find the Windows 10 (64-bit) operating system
IS supported.

4

Windows OS

Note that the information included on the following pages is for Windows 10 only. In order to run Windows 10 (64-bit)
your computer requires a minimum 4GB of system memory (RAM).

Overview 1 -3
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System Startup

1. Remove all packing materials, and place the computer on a stable surface, and securely attach any peripherals you want to
use with the notebook (e.g. keyboard and mouse) to their ports.

2. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an outlet, and
connect the AC power cord to the AC/DC adapter (make sure you use the adapter when first setting up the computer, as
to safeguard the computer during shipping, the battery will be locked to not power the system until first connected to the AC/
DC adapter).

3. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 135 degrees); use the other
hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).

4. Press the power button on the top of the computer for about 2 - 3 seconds to turn the computer “on” (note that the power
LED on the front of the computer will turn from orange to green when the computer powers on).

\

4

Shutdown

Note that you should
always shut your
computer down by

choosing the Shut
Down command in
Windows (see page
1 - 44). This will help
prevent hard disk or
system problems.

Figure 1 - 1 - AC/DC Adapter In / Opening the Lid/LCD

1 -4 System Startup



Model Differences
This notebook seriesincludes Four different modelsthat vary slightly in design style, color and general appear-
ance. Note that though your computer may look slightly different from that pictured throughout this manual, all
ports, jacks (other than those indicated below and in specification) and general functions are the samefor al the
design styles (see Appendix D for further details).

Quick Start Guide

Feature Model A Model B Model C Model D
3G/4G Supported Not Supported Not Supported
Module
Fingerprint Supported Not Supported Supported Supported
Reader
Display 15.6" (39.62cm) 16:9 Panel 16.1" (40.89cm)16:9 Panel 17.3" (43.94cm) 16:9 Panel
Design

Table 1 - 1 - Model Differences

System Startup 1 -5
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Figure 1 - 2 LCD Panel Open - Model A

LCD Panel Open
Model A

Built-In PC Camera

PC Camera LED

3. Built-In Array
Microphone

4. LCD

5. Power Button

6. *lluminated (White)
LED Keyboard

7. TouchPad & Buttons

8. Fingerprint Reader

(Factory Option)

N

Note that the Touchpad/
Clickpad and Buttons has
a valid operational area
indicated within the dot-
ted lines above.

*A colored LED key-
board is available as an
option for this model.

1 -6 LCD Panel Open - Model A
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Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices (e.g. WLAN, Bluetooth
or 3G/4G) aboard aircraft is
usually prohibited. Make
sure any wireless modules
are OFF (i.e. the system is in
Airplane Mode) if you are
using the computer aboard
aircraft.

Use Fn + F11 Airplane
Mode key combination to
toggle Airplane Mode On/
Off, and check the LED indi-
cator for the power status.




LCD Panel Open - Model B

MNL
il
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices
(e.g. WLAN, Bluetooth or 3G/
4G) aboard aircraft is usually
prohibited. Make sure any
wireless modules are OFF (i.e.
the system is in Airplane
Mode) if you are using the

computer aboard aircraft.

Use Fn + F11 Airplane Mode
key combination to toggle Air-
plane Mode On/Off, and check
the LED indicator for the power
status.

Quick Start Guide

Figure1-3
LCD Panel Open
Model B

1. Built-In PC Camera

2. PC Camera LED

3. Built-In Array
Microphone

4, LCD

5. Power Button

6. *lluminated (White)
LED Keyboard

7. TouchPad & Buttons

Note that the Touchpad/
Clickpad and Buttons has
a valid operational area
indicated within the dot-
ted lines above.

*A colored LED Kkey-
board is available as an
option for this model.

LCD Panel Open - Model B 1-7
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Figure 1 - 4 LCD Panel Open - Model C

LCD Panel Open
Model C

Built-In PC Camera

PC Camera LED

3. Built-In Array
Microphone

4. LCD

5. Power Button

6. lluminated (White)
LED Keyboard

7. TouchPad & Buttons

8. Fingerprint Reader

(Factory Option)

N

Note that the Touchpad/
Clickpad and Buttons has
a valid operational area
indicated within the dot-
ted lines above.

1-8LCD Panel Open - Model C
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Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices (e.g. WLAN, Bluetooth
or 3G/4G) aboard aircraft is
usually prohibited. Make
sure any wireless modules
are OFF (i.e. the system is in
Airplane Mode) if you are
using the computer aboard
aircraft.

Use Fn + F11 Airplane
Mode key combination to
toggle Airplane Mode On/
Off, and check the LED indi-
cator for the power status.




LCD Panel Open - Model D

MNL
il
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices
(e.g. WLAN, Bluetooth or 3G/
4G) aboard aircraft is usually
prohibited. Make sure any
wireless modules are OFF (i.e.
the system is in Airplane

Mode) if you are using the
computer aboard aircraft.

Use Fn + F11 Airplane Mode
key combination to toggle Air-
plane Mode On/Off, and check
the LED indicator for the power
status.

Quick Start Guide

Figure1-5
LCD Panel Open
Model D

1. Built-In PC Camera

2. PC Camera LED

3. Built-In Array
Microphone

4. LCD

5. Power Button

6. *lluminated (White)
LED Keyboard

7. TouchPad & Buttons

8. Fingerprint Reader
(Factory Option)

Note that the Touchpad/
Clickpad and Buttons has
a vaid operational area
indicated within the dot-
ted lines above.

*A colored LED Kkey-
board is available as an
option for this model.

LCD Panel Open - Model D1 -9
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LED Indicators
The LED indicators at the front of the computer display helpful information about the current status of the sys-

tem.
Icon Color Description
8 ] & | o i }
Orange AC/DC Power is Plugged In
D_/(D Green The Computer is On
Blinking Green The Computer is in Sleep Mode
Orange The Battery is Charging
d ” || Blinking Orange The Battery has Reached Critically Low Power Status
Green The Battery is Fully Charged
+ Green Airplane Mode is ON (the WLAN, Bluetooth & 3G/4G Modules are OFF)
% Green HDD Activity

Table 1 -2 - LED Indicators

1-10LCD Panel Open - Model D



llluminated White LED Keyboard
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4

Theilluminated white L ED keyboar d has an embedded numerical keypad for easy

numeric data input, and features function keys to allow you to change operational
features instantly. See Table 1 - 5, on page 1 - 19 for full function key combination

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can

use any standard USB

details.
= N # Il Function Keys ( ) - +
k 1 2 3 ||4 5 6 T |8 0 - =

Windows Logo Key

Figure 1 - 6 - llluminated White LED Keyboard

keyboard. The system will

detect and enable it auto-

matically. However spe-

cial  functions/hot-keys

+ unique to the system’s
regular keyboard may not
work.

ScrLk &

t || rowe

' 'K. : R EEREE \N\umLk Keys i -
i | =l Numerical
< F 1 :, i Keypad
[, |- Il A o | 6 Scr Lk

i

EN| Menu/Application Key [REN

Hold down the Fn Key
and Scr Lk to enable
scroll lock and check the
LED indicator for status.

4

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

llluminated White LED Keyboard 1 - 11
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4

Other Keyboards

llluminated Color LED Keyboard

Theilluminated colored keyboar d has an embedded numerical keypad for easy nu-
meric data input, and features function keys to alow you to change operational fea-
If your keyboard is dam- || tures instantly. See Table1 - 5, on page 1 - 19 for full function key combination
aged or you just want to | detgjls, and see “ Keyboard Backlight LED Device” on page 1 - 16.

make a change, you can

use any standard USB = = — —_— . ——T——w—— —_— — T s = st . —— o
keyboard. The system will Bsc | |Pw Fem .F:? ® _Fd Function KeyS Bar| | P FID@ F11+ ri | s,,3§| 5:-'E-<| Bl | | Home | | End _:;?ub,]; ;?f.’,.‘
detect and enable it auto- - Y M= 1A~ *=1c1[7]1=]1] ger T [y  o— 1 —

> -« || Play/Pause Ke Scr Lk Ke vl IS EA B
matically. However spe- - ~ayrrause ey, LS JLE L7 JLejLejLo 2 = L A | A )

cial functions/hot-keys T a U 1
unique to the system’s kil | . @
regular keyboard may not =

E
work. i E] E] E] EfLe L)L) == LS numerical] s

r[ 7l vl[ul[][allel[ ][] iNumlkKey|s
N A

Pglip

Home

Scr Lk £ Shift Game CiOITlItrIC3| .Kel_)'/s Vv J| B | N 1 A Mgnu/AppIiQQtiOh Key & ;'1,, }éezp'a_ian —_
17 [~ Windows Logo Key —f 0
Hold down the Fn Key ctrl fo || @ | A Aw || B §c “ v | 7l | T
and Scr Lk to enable ) ! o b ) e )
scroll lock and check the Figure 1 - 7 - llluminated Color LED Keyboard

LED indicator for status.
Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1-12 llluminated Color LED Keyboard
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Control Center

When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click theicon ﬂ inthenotification area of thetaskbar to toggle the Control Center on/off. The Con-
trol Center gives quick accessto frequently used controls and enables you to quickly turn the camera/touch pad
on/off.

4

Control Center Access

To run the Control Center
press the Fn + Esc key com-
bination, or double-click the

icon q in the notification
area of the taskbar.

Close the Control Center by
clicking the @ close icon in
the top right of the panel.

Figure 1 - 8 - Control Center

Control Center 1 - 13
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Flexikey® Application

The Flexikey® application isaquick hotkey configuration application, which allowsyou to assign asinglekey
to launch multiple key combinations, or to launch programs and applications, to create text macr os and to
disable certain keys. The application can also be used to configure the mouse buttons to create hotkeys for
gaming etc. All the configuration settings are retained under (up to12) profiles to which the settings are applied.
Click Flexikey in the Control Center to launch the application.

¢ CONTROL CENTER B.O X s
/Q\

Windows Key F-
Fn & P Keys

Note that you can
assign actions to
any keyboard key
except the Win-
dows key FH Fn

and P key.

Alwoin Kayimant

Figure 1 - 9 - Flexikey® Application

.|
1 - 14 Flexikey® Application
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« EXPRESSKEY - Thisfeature allowsyou to configure asingle key to send multiple key combinations or to
create more useful shortcut keys. Thisis useful in gaming or when using applications which have a complex
set of keyboard shortcuts.

» LAUNCH APP - Thissimply assigns single keysto launch any program’s or application’s executablefile.
» EXPRESSTEXT - With thisyou can assign single keys to send commonly used strings of text.

* DISABLE - Use thisfunction to disable any keyboard keys.

» STATISTICS - Use thisto quickly record keysin use in any application, and to disable unused keys.

Flexikey® Application Features

.|
Flexikey® Application 1 - 15
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Keyboard Backlight LED Device

(For llluminated Colored Keyboards Only)

Press Fn plusthe |- | @ key to toggle the keyboard LED on/off. The keyboard LED may be configured using

the Fn + key combination outlined in the table below. In addition press Fn plusthe |- | @ key to launch the

keyboard backlight application to configure the settings (see “ Keyboard Backlight LED Device (for Illuminat-

ed Colored Keyboards)” on page B - 10).

Main Keyboard Colored LED Function key Combinations
Fn + ‘- o Launch the Keyboard Backlight Application T ) ] i b‘ Ub i
[ 9 Toggle the Keyboard Backlight LED On/Off = ' a a
Fn+ | 7‘ 9 Keyboard Backlight LED Low ' 43 ' 65 ' g ' B
Ens @ «eyboard Backlight LED High = E

‘ e Enter

Fn + -.:L' eToggle the Left Keyboard LED On/Off l J—'”’
Fn+ @Toggle the Middle Keyboard LED On/Off Middle Right
Fn + o aToggIe the Right Keyboard LED On/Off

Table 1 - 3 - Main Keyboard LEDs (for llluminated Colored Keyboards Only)

1-16 Keyboard Backlight LED Device
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LED Device Menu

The LED Device menu in the Control Center can be used to configure the LED Backlight for illuminated white
and colored keyboards (see“ LED Device Menu” on page B - 9/“ Keyboard Backlight LED Device (for Illumi-
nated Colored Keyboards)” on page B - 10).

Figure 1 - 10 - LED Device (Illuminated White or Colored Keyboards)

. |
LED Device Menu 1 - 17
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Keyboard Shortcuts

4 The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navi-

Windows Logo gation/operation in Windows 10.
Keyboard Shortcut

Windows Logo

Use the Windows logo = ey 4 Description

ki ul _ Ll |
ey gm + D key com

bination to switch be- Tap Winkey Toggle the Start menu

tween the Start screen -

and Windows Desktop. A Open the Action Center
Menu/Application B Select the Taskbar Notification Area
Keyboard Shortcut C Launch Cortana (in listening mode)

When the Desktop app D Toggle the Desktop
iS running you can use

the Menu/Application E Launch File Explorer (Quick Access tab)

key [E] on the key- + Number (1, 2, etc) | Launch an application from the taskbar (numbered from left to right)
board to display the

context menu as per a Table 1 - 4 - Keyboard Shortcuts

mouse right-click.

1-18 LED Device Menu
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Function Keys & Visual Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down.

Keys Function/Visual Indicators Keys Function/Visual Indicators

Fn+|! Automatic / Full eliings
- Povier

Fn+ s Play/Pause (in Audio/Video Programs)

Fn+| Esc Control Center Toggle (see over)

Display Toggle

Brightness Decrease/Increase

— ==

PC Camera ©  CAMERA ON
Power Toggle

Turn LCD Backlight Off
(Press a key to or use Touchpad to turn on)

| En+ [F11_| Airplane »)- Airplane mode on
Fn + " @) Mute Toggle s Mode Toggle

all  Airplane mode off

For Backlight

Fn+ Fé . Keyboards Only g Fn+ [FiZ B Sleep Toggle
= Toggle Off/High/Low —

Fn+ F9 e Pt Volume Decrease/Increase

Table 1 -5 - Function Keys & Visual Indicators

Function Keys & Visual Indicators 1 - 19
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Figure 1 -11
Front & Rear Views
All Models

1. LED Power Indica-
tors
2. Vent/Fan Intake

2N
1§

Overheating

To prevent your comput-
er from overheating
make  sure  nothing
blocks the vent(s)/fan in-
take(s) while the comput-
erisin use.

Front & Rear Views - All Models
Models A & C

2 Model D 2

1-20 Front & Rear Views - All Models
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Right Views Figure 1 - 12
Right Views

Headphone Jack
Microphone Jack
1*USB 2.0 Port
1 * Type-A USB
3.0 Port (USB 3.1
Genl)

Vent/Fan Intake
Security Lock Slot
(Models A& C
Only)

PR

oo

\ o/
USB Ports 7&(

This model includes 1* USB 2.0 port, 1 * Type-A USB 3.0 (USB 3.1, Genl) port, 1 * Type-A USB 3.1 USB Ports
(USB 3.1, Gen?2) port and 1 * Type-C USB 3.1 (USB 3.1, Gen 2) port (see page A - 4).

Note that the connec-
tions to the USB ports
only fit one way, do not
force them.

Right Views 1 - 21
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Figure 1 -13 Left V| ews
Left Views

DC-In Jack

RJ-45 LAN Jack

Mini DisplayPort 1.2

Mini DisplayPort 1.3

HDMI-Out Port

1* Type-C USB 3.1

Gen2 Port

1*Type-AUSB 3.1

Gen2 Port

8. Multi-In-1 Card
Reader

9. Security Lock Slot

(Model D Only)

ocuArwNE

~

Multi-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

4

HDMI Port

Note that the HDMI Port
support video and audio
signals to attached exter-
nal displays.

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

USB Ports

This model includes 1* USB 2.0 port, 1 * Type-A USB 3.0 (USB 3.1, Genl) port, 1 * Type-A USB 3.1
(USB 3.1, Gen2) port and 1 * Type-C USB 3.1 (USB 3.1, Gen 2) port (see page A - 4).

1-22 Left Views
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4

Mini Display Ports / HDMI Port

All external and internal displays (up to 4 active displays) can be configured from Windows by using System (in Settings
- page C - 7) control panel, or the == + P (or Fn + F7 - page C - 6) key combination. It is recommended that you use the
Windows controls to configure multiple displays. in addition you can use any of the following to configure external displays
attached to a particular port. In addition to the Windows controls, use any of the following to configure external displays
attached to a particular port.

Mini Display Port 1.2 e: If you wish to configure an external display connected to Mini Display Port 1.2 use the Intel
UHD/HD Graphics control panel (see “Intel® HD/UHD Graphics Control Panel” on page C - 15) to configure the dis-
play configuration.

Mini Display Port 1.3 9: If you wish to configure an external display connected to Mini Display Port 1.3 use the NVIDIA
Control Panel (see “NVIDIA Control Panel” on page C - 32) to configure the display configuration.

HDMI Port @): If you wish to configure an external display connected to the HDMI Port use the Intel UHD/HD Graphics
control panel (see “Intel® HD/UHD Graphics Control Panel” on page C - 15) to configure the display configuration.

Note that this computer supports virtual reality (VR) headsets, however VR headsets must be connected to the Mini
Display Port 1.3 @.

See Appendix C for full information on external display configuration.

Figure 1 - 14 - Left Side View (Mini Display Ports & HDMI Port Highlighted) - Single Model Pictured

Left Views 1 - 23
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Y% 4G Module USIM Card Installation (for Models A & B)

Power Safety Follow the instructions below to install the USIM card (which will be supplied by
Warning your service provider) which requires the removal of the battery first.

SOV EIRNEEIERCEWAE 1. Turn the computer off, and turn it over.

::Ztlf‘;'a;'j:‘e thafrogﬁd;‘]zse' 2. Slide the latch @ in the direction of the arrow, and then slide latch @) in the
twurned off the poywer' and direction of the arrow and hold it in place.

e e o @ 3. While holding the latch @ in place, pull the battery up at point @ in the direction of
als and cables (including the arrow @ to remove the battery @.

telephone lines). 4. Insert the USIM card @ (see overleaf).

5. Reinsert the battery (see page 1 - 26).

Figure 1 - 15
Battery Removal &
USIM Card Insertion

1 - 24 4G Module USIM Card Installation (for Models A & B)
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4G Module USIM Card Installation

Insert the USIM card @ asillustrated below (pay careful attention to the orientation —
of the card asthe gold contact side of the card should face downwards) until it clicks 2§
fully into position. To gject the card simply pressit until it gects, but do not attempt USIM Card
to gject the card while connected to a 4G network (see below). Orientation

Note that the USIM

card’'s readable side
(with the gold-colored
contacts) should face
downwards as illustrat-
ed.

Figure 1 - 16
USIM Card Insertion

2NZ
Z &

USIM Card Ejection

Simply press on the USIM card to eject it, however do not do this while a connection is in
progress. If you do eject the card while a 4G connection is ongoing, you will need to shut
down the system, reinsert the USIM card, restart the system and then reestablish the 4G con-
nection.

If you wish to change USIM cards then you will need to shut the system down, reinsert the
USIM card, restart the system and then reestablish the 4G connection.

.|
4G Module USIM Card Installation (for Models A & B) 1 - 25
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Battery Insertion

1. Orientate the battery @ as illustrated below and align it with the edges of the bat-
tery compartment.

2. Push the battery in the direction of the arrow @ to insert it into the compartment (it
should click into place).

3. Slide the latch @) in the direction of the arrow into the lock position.

Figure 1 - 17
Battery Insertion

1-26 4G Module USIM Card Installation (for Models A & B)
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Bottom View - Models A & C Figure 1 - 18

Bottom View
7£l< Models A & C
Overheating 1. Battery
2. Fan Outlet/Intake
To prevent your comput- 3. Speakers

er from overheating
make sure  nothing
blocks the vent(s)/fan in-
take(s) while the com-

puter is in use.

Bottom Cover Removal
Warning

Do not remove any cover(s)
and /or screw(s) for the pur-
poses of device upgrade as
this may violate the terms

Y of your warranty.
. If you need to replace/re-
Battery Information move the hard disk/RAM/

. L. optical device etc., for any
Always completely discharge, then fully charge, a new battery before using it. Completely reason, please contact your

discharge and charge the battery at least once every 30 days or after about 20 partial dis- distributor/supplier for fur-
charges. ther information.

Bottom View - Models A& C 1 - 27
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Figure 1 - 19 Bottom View - Model B

Bottom View

Model B il:

1. Battery Overheating
2. Fan Outlet/Intake
3. Speakers To prevent your comput-

er from overheating
make sure  nothing
blocks the vent(s)/fan in-
take(s) while the com-

puter is in use.

Bottom Cover Removal
Warning

Do not remove any cover(s)
and /or screw(s) for the pur-
poses of device upgrade as
this may violate the terms
of your warranty.

If you need to replace/re- .
move the hard disk/RAM/ Battery Information
optical device etc., for any
reason, please contact your

Always completely discharge, then fully charge, a new battery before using it. Completely
distributor/supplier for fur- discharge and charge the battery at least once every 30 days or after about 20 partial dis-
ther information. charges.

1-28 Bottom View - Model B



Bottom View - Model D

Battery Information

Always completely discharge, then fully charge, a new battery
before using it. Completely discharge and charge the battery
at least once every 30 days or after about 20 partial discharg-
es.

2 &

Overheating

To prevent your comput-
er from overheating
make  sure  nothing
blocks the vent(s)/fan in-
take(s) while the com-
puter is in use.

Bottom Cover Removal
Warning

Do not remove any cov-
er(s) and /or screw(s) for
the purposes of device
upgrade as this may vio-
late the terms of your
warranty.

If you need to replace/re-
move the hard disk/
RAM/optical device etc.,
for any reason, please
contact your distributor/
supplier for further infor-
mation.

Quick Start Guide

Figure 1 - 20
Bottom View
Model D
1. Battery
2. Fan Outlet/Intake
3. Speakers

N2
2

Battery Removal

Note that the built-in
battery is not user re-
movable. Removing the
battery will violate the
terms of your warranty.

If you need to remove the
battery for any reason,
please contact your dis-
tributor/supplier for fur-
ther information.

Bottom View - Model D 1 - 29
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Windows 10 Start Menu

Most of the apps, control panels, utilities and programs within Windows 10 can be accessed from the Start
Menu by clicking theicon gg in the taskbar in the lower |eft corner of the screen (or by pressing the Windows

Logo Key 2@ on the keyboard).

4

Windows Screens

Note that the Win-
dows screens on the
following pages are
included as a basic
guide and introduc-
tion to navigating
around Windows 10.

However note that
these screens are al-
ways subject to
change, upgrade and
redesign. Check the
Microsoft website for
detalils.

Recently added
i—' OpenOffice Writer

’e" OpenOffice Base

BI OpenOffice Cale Calendar Mail
Expand

pef
& n

Instagram c
s Get Office

A
Alarms & Clock

C

-

Calendar

Camera

By :

B Candy Crush Soda Saga
™ Connect

O corena

[

0 hype nere tu tearch

We speak Gmail

OneNote  [3

Figure 1 - 21 - Windows Start Menu

1-30 Windows 10 Start Menu
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Right-Clicking the Windows Logo In Start Menu

Right-click the Start Menu gg icon (or use the Windows Logo Key g@ + X key combination) to bring up an
advanced Context M enu of useful features such as Apps and Features, Power Options, Task Manager, Search,
File Explorer, Device Manager, Computer Management and Network Connections etc.

Apps and Features
Mobility Center

Power Options

Event Viewer

System

Device Manager
Network Connections
Disk Management
Computer Management
Windows PowerShell

Windows PowerShell (Admin)

Task Manager

Settings

Right-Click Icon

File Explorer

Search

lown or sign out

R

Figure 1 - 22 - Right-Click Windows Logo in Start Menu

. |
Windows 10 Start Menu 1 - 31
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Start Menu Apps & Tiles

The Windows 10 Start Menu will contain a number of apps, and many more will be installed as you add more
applications etc. Not al of these apps can fit on the screen so may need click and drag the handles at the edge of
the screen to expand the menu in order to view all the apps (you can use the scroll bar to move up and down the
screen).

Calendar Mail ~]

® 0

Get Office OneNote {2

Suggested

Ictagram

Aok

(ST holter thEE-\

A
Alarms & Clock.

R Type here to search

Figure 1 - 23 - Expanding the Start Menu

. |
1-32 Windows 10 Start Menu
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Pining/Unpinning Apps & Programs to/from the Start Menu

To make things easy to find you can add and remove tiles for apps and programs to the Start Menu. Right-Click
on aprogram’sicon and select Pin to Start from the drop-down menu. To remove an app or program from the
Start Menu right-click the icon and select Unpin from Start. Y ou can use the same method to pin apps/pro-
gramsto/from the taskbar (select pin to taskbar/unpin this program from the taskbar).

Open

Run with graphics processor
Open file location

!; Run as administrator
Troubleshoot compatibility
Pin to Start

Ea Scan with Windows Defender...

Pin to taskbar

Restore previous versions

Send to

Cut
Copy

Create shortcut
Delete

Rename

Properties

Recently added Create
’. OpenOffice Writer
!. OpenOffice Base We speak Gmail

1 ‘OpenOffice Calc Calendar

Expand ™

pef
& n

@ Siegecraft Defender Get Office OneNote @7
*okks

A I )
Alarms & Clock @

. ﬂ [t G| tonch of 0l

i cocuior T —
. — 58 Unpin from Start 5
[ Calendar /
Camera ®

8] Connect

B e

F

Bl rocebook

[l

New window

New InPrivate window

£ Type here to search

Figure 1 - 24 - Pin to Start/Unpin from Start

Windows 10 Start Menu 1 - 33
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Windows 10 Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of waysin Windows 10.

» Select Control Panel
under the Windows
System item in the
Start Menu.

» Type Control Panel
into the Search box in
the taskbar and click on
the icon when it pops

up.
* You can pin the Con-

trol Panel tileto Start
or taskbar.

w 3D Preview
Create

Voice Recorder

:._’ Weather
Calendar

& 0

Get Office

B Windows Accessories

B Windows Administrative Tools

== Windows Defender Security Center

. Windows Ease of Access
. ‘Windows PowerShell
. Windows System

a

= Command Prompt
QBB Control Panel \,
P Fiie Bplorer = Pin to Start

= ron More

Store

q Task Manager R t
‘g This PC Windows Administrative Tools

X Storage Spaces

';‘ Xbox

Figure 1 - 25 - Windows 10 Control Panel Access

& & Filters
Best match.

Control Panel
Desktop app

[E1 Settings

Settings

]

= Set up USB game controllers
Change User Account Control settings
App & browser control

Connect wireless Xbox One controllers

Ea =R

Change how Marrator reads hints
for controls and buttons

@ Control the computer without the mouse
or keyboard

Search suggestions

£ control - search the web

1 - 34 Windows 10 Control Panel
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Settings
The Settingsitem in the Start Menu (and also as an App) gives you quick access to anumber of system settings
control panels allowing you to adjust settings for System, Devices, Network & internet, Personalization, Apps,

Accounts, Time & language, Gaming, Ease of Access, Privacy and Update & security.

Windows Settings

System Phaone Network & Intemet
o— m
O —
— )
Z = L AT

Personalization Apps Accounts Time & Language

M Type here to search

Figure 1 - 26 - Settings

. |
Windows 10 Control Panel 1 - 35
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Windows 10 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of the task-
bar. The notification area of the taskbar in the bottom right of the screen. Some of the Control Panels and appli-
cations referred to throughout the course of this manual can be accessed from here.

Taskbar

Taskbar - Pinned Programs and Apps Notification Area
Figure 1 - 27 - Taskbar

Y ou can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “ Pining/
Unpinning Apps & Programs to/from the Start Menu” on page 1 - 33).

1 - 36 Windows 10 Control Panel
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Action Center

The Action Center appears as avertical panel on the right side of the screen when you swipe in from the right
or click the button in the notification tray. This gives you access to commonly needed functions like Network,
All Settings, Airplane Mode, and Project etc.

P OneDrive

Get to your files from anywhere

Clear all

= @ €
Connect Network All settings

i ®)

Location Quiet hours

son  Cuiethous  100% Ba Project

Lt
= r
VN

aght light

10:17 AM
Bl

Hj - g '|::|:|
. T4 10/31/2017

Figure 1 - 28 - Action Center

Windows 10 Control Panel 1 - 37
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Video Features

Y ou can switch display devices, and configure display options, from the Display Settings control panel. In Win-
dows 10 it is possible to quickly configure external displays from the Project menu (press the Windows logo
key =@ on your keyboard and the P key).

Microsoft Hybrid Graphics

Y our computer will feature Microsoft Hybrid Graphics switchable graphics technology. This seamless tech-
nology is designed to get best performance from the graphics system while allowing longer battery life, without
having to manually change settings. The computer’ s operating system (and some applications) will automati-
cally switch between the integrated UMA (Unified Memory Architecture) GPU (iGPU) and the discrete GPU
(dGPU) when required by the applications in use. This switch is seamless to the user.

The basic video features for this computer can be configured using the Intel® UHD/HD Graphics Control
Panel. Further video configuration is available through the NVIDA control panel (see the information on the
following pages and Appendix C). It is recommended that you use the Windows controls to configure multiple

displays.

1 - 38 Video Features
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To Configure Displays using Project

1. Attach your display to the appropriate port, and turn it on.

2. Pressthe g@ + P key combination.

3. Click on any one of the options from the menu to select PC screen only,
Duplicate, Extend or Second screen only. ECea=cn ety

4. You can also click Connect to a wireless display at the bottom of the
Project screen and follow the steps to connect to any wireless enabled
display.

Project

Duplicate

4

Intel or NVIDIA Video Driver Controls

More detailed video controls are provided by the Intel/NVIDIA Control Panel
(for more detailed information see Appendix C).

Second screen only

You can also access the control panel by right-clicking the desktop and select-
ing Intel(R) Graphics Properties/NVIDIA Control Panel.

Figure 1 - 29 - Project (Devices)

Video Features 1 - 39
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To access the Display Settings:

1. You can quickly adjust the display by right-clicking the desktop and selecting Display Settings.

2. Adjust the settings for Brightness and color, Scale and layout, Resolution and Orientation from the menus.

3.  When and external display is attached you can arrange the display configuration from the Multiple Displays
menu, and arrange the configuration from Select and rearrange displays.

4. Click Apply to save any changes made.

Settings

Vi 2

i > Display

Sort by 2 %

Refresh @ Home DISpiay Select and rearrange displays

Pt Find a setting Brightness and color Select a display below to change its settings. Some settings are apphied to all displays.

Paste shortcut Change brightness

A
B nvIDIA Control Panel -
| O Display Night light

il - @ on
. . L] Notifications & actions 1
=3 Display settings Night light settings
| &) Power & sleep

Scale and layout

= Battery
Change the size of text, apps, and other items . ) ty
= Storage 100% (Recommended) |
G Toblet mode Custam scaling sl
ultple displays
Resolution p p y

IO Multwtasking

1366 » 768 (Recommended) | Duplicate these displays

@' Projecting to this PC Orientation Extend these displays

| Land: 3 |
7% Shared experiences Anccape Show only on 1

3¢ FRemote Desktep Show only on 2

Multiple displays

© About . Display adapter properties
Older displays might not always connect automatically. Select

Figure 1 - 30 - Display Settings

1 - 40 Video Features



Quick Start Guide
To access the Intel(R) UHD Graphics Control Panel:

1.
2.
3.

Access the Intel Graphics Control Panel from the Start menu in Windows.

You can right-click the Intel Graphics Control Panel in the Start menu and pin the control panel to the taskbar
Use the Ctrl + Alt + F12 key combination shortcut to open the Intel Graphics Control Panel

Recently added

. e Intel® UHD Graphics Control Panel
@

® 3D Viewer

A

Alarms & Clock
[«
E Calculator
Calendar Mostly Clear =

. . TUNE YOUR GAME FOR INTEL GRAPHICS
. Camera 46" M8

Better ENViro

-
Microsoft Store

ailed Characters. More Exciting Effects.

&H#@o

Gaming Power Options and
Support

£ fiype here to search

Figure 1 - 31 - Intel® UHD Graphics Control Panel
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To access the NVIDIA Control Panel:

1. Access the NVIDIA Control Panel from the Start menu in Windows (or right-click the desktop and select
NVIDIA Control Panel).

2. To configure displays in Discrete mode use the NVIDIA Control Panel (see page C - 17).

NVIDIA Control Panel

File Edit Desktop 3D Seftings Help

Q ek 'O| )

‘SelectaTask... n 7 L .
T .. Adjust Image Settings with Preview
' sl R o
r-Manage 30 settings
«.Configure Surround, PhysX

This page allows you to preview changes you make to the image and rendering settings. These will be your default settings for your
hardware-accelerated 3D applications that utiize Direct3D or OpenGL.

Performance: Preview:

1 Display settings
& Personalize

Quality:

What do I look for?
Micresaft £
Moving towards the (®)Let the 3D appication decide
Performance side wil " "
increase frame rate, (D) Use the advanced 30 image settings ~ Take me there
but curved lines il (O Use my preference emphasizng: Quality
appear jagged,
Moving towards the
Quality side il mprove
the smoothness you
can se= on curved lines.

Description:

Microsoft News  Paint 3D

[8) system Information Typical usage scenarios:
v
2 |H«'pt‘ here to search I =}, 7 2]

Figure 1 - 32 - NVIDIA Control Panel
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Minimum Screen Resolution Settings

Quick Start Guide
1. Windows 10 has minimum screen resolution requirements.
2. Right-click a blank area of the Desktop and select Display Settings.

3. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above.
% Home Display

| Find a setting el I Night light settings

Scale and layout
System

Change the size of text, apps, and other items
I 3 Display

| 100% (Recommended) -]

L] Notifications & actions Custér Salifig

& Power & sleep Resolution
( 1920 x 1080 (Recommended) )

= Battery

1680 = 1050
—= Storage 1600 = 1200

1600 = 900
L@ Tablet mode

1440 = 900
01 Multitasking 1400 = 1050

1366 = 768
&1 Projecting to this PC

1360 = 768

MM LR S S S o o

Figure 1 - 33 - Display (Resolution)
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Quick Start Guide

Power Options

Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power button item in
Start Menu (or the context menu) may be used to Shut down or Restart (you can aso add Hiber nate/Sleep to
the menu - see page 1 - 45). To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to perform the function selected.

Using the Power Button

1. Go to the Start Menu.

2. Click the Power button .

3. Select the power state required from
the menu.

‘We speak Gmail

£ Type hete to search

Figure 1 - 34 - Shut Down/Restart

1 - 44 Power Options



Quick Start Guide

Y ou can also use the context menu (right-click the Start Menu gg icon or pressthe Windows logo 28 + X key
combination) to Sign out, Sleep, Hibernate, Shut down, and Restart.

4

Adding Hibernate/Sleep to the Power Men

1. Go to the Power Options (Hardware and Sound) control
panel (or go to Windows Settings > Power & sleep >
Additional power settings).

2. Click Choose what the power buttons do.

3. Click “Change settings that are currently unavailable”

; By Change settings that are currently unavailable .

B 4. Click to put a check in the Hibernate/Sleep box under

Sete Shutdown settings.

e Bipores Seep 5. Click Save Changes and close the control panel.

Sraech

Figure 1 - 35 - Context Menu Shut Down or sign out

Ctrl + Alt + Delete Key Combination

You can usethe CTRL + ALT + DEL key combination to bring up a full-screen displaying L ock, Sign out,
Changeapassword, Task Manager and Switch User. If you click the Power iconin the lower right corner of
the screen a power management option menu appears to display Sleep, Hiber nate, Shut down, and Restart.

.|
Power Options 1 - 45
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Storage Devices, Mouse, & Audio

Chapter 2. Storage Devices, Mouse, & Audio

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive/Solid State Drive
Multi-in-1 Card Reader

Realtek Audio Console

Touchpad and Buttons/Mouse

. |
Overview 2 - 1
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e Hard Disk Drive/Solid State Drive

T e — The hard disk drive (HDD) and/or solid state drive (SSD) is used to store your data
Removal Warning in the computer. The hard disk can be taken out to accommodate other serial (SATA)
hard disk drives (see “ Storage” on page D - 2 for specification information), how-
S L DN ey (0 ill need to contact your distributor/supplier to do this in order to avoid
O e e ) everyouwill n o contact your distributor/supplier to do this in order to avoi
G e el e- @ violating the terms of your warranty.

upgrade as this may vio-
late the terms of your
warranty.

If you need to replace/
remove the hard disk for
any reason, please con-
tact your distributor/sup-
plier for further
information.

2 - 2 Hard Disk Drive/Solid State Drive
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Multi-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the Z
card into the slot and it will appear as a removable device, and can be accessed in Push-Push Card
the same way as your hard disk (s). Make sure you install the Card Reader driver Reader
(see“ Card Reader” on page4 - 8). The card reader fea-
. . tures a push-in/push-out
e MMC (M u|t||\/|edIaCard) /| RSMMC card insertion and ejec-

e SD (Secure D|g|ta|) / Mini SD / SDHC/ SDXC tion mechanism. Simply

push the card to insert

Note: Some of these cards require PC adapters that are usually supplied with the | and eject it, however Ms

cards. Duo cards require an
adapter.

Figure2-1
Left View

1. Card Reader

Multi-in-1 Card Reader 2 - 3
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4

Volume Adjustment

The sound volume level
can be clicking using the
volume control icon

in the notification area
of the taskbar.

Figure2-2
Realtek Audio
Console
(Windows Start
Menu)

Realtek Audio Console

Y ou can configure the audio options on your computer from the Sound - control
panel in Windows, or from the Realtek Audio Console Windows Start menu.
Make sure you have installed the driver and checked the Microsoft Store for
updates (see “ Audio” on page 4 - 9). The volume may also be adjusted by means
of the volume icon in the taskbar or the audio dlider in the Settings menu (see

sidebar).

* Paint 3D
People

Photos

. | Realtek Audio Console

Settings

Skype

und Blaster Connect

Sticky Notes

Create

Play

More ways

We speak Yahoo to play. Join

Calendar
Get Office

Explore

Microsoft Store

<
=3
— -

OneNote @@

e

Microsoft Edge

S]

Skype

2 - 4 Realtek Audio Console
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Realtek Audio Console - Main

Y ou can adjust the Speaker and Microphone levels by using the slidersin the Re-
altek Audio Console Main window.

Realtek Audio Console = a =
- W Main Playback Devices
[ Speakers W Figure 2-3
whack Devices S — Omee O Realtek Audio
@ speakers Console
el it Recording Devices (Main)
N Mi‘m;]h‘m. Microphone & ¢

ﬁ' Device advanced settings
B Power Management

o Information

Realtek Audio Console 2 - 5
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Realtek Audio Console - Speakers
Click Speakersto access controls for the format and speaker balance etc.

Realtek Audio Corsole

A Main Main Volume
Balance

§ O mMute 1—F—nr

Figure2-4
Realtek Audio | @ spesiers
Console [z _
(Speakers) ["aso00mz 24815 | R

&  Microphone

Default Format

Select the sample rate and bit depth to be used when running in shared mode.

Speaker Configuration

Full-range Speakers

Front left and right

B

':} Device advanced settings
W) Power Management

o Information

2 - 6 Realtek Audio Console
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Realtek Audio Console - Microphone

Click Microphone to access advanced controls for recording on the microphone.
Adjust the recording Main Volume level to around 60, to obtain the optimum re-
cording quality. The On-Screen menu which appears will depend on whether or not
you have enabled Cortana.

Figure2-5
Realtek Audio Coraale . o * Rea|tek Au d | 0
A Main Main Volume Console
= [ mute .
Microphone Boost (M|C|'0ph0ne -
€ speakers G200 | Cortana)
3 M__.“_[ o Microphone Effects
® il off QO uni-Directional (] Omni-Directional_
) [ ]
AR Jiaan

@

L} Device advanced settings Default Format

Select the sample rate and bit depth to be used when running in shared mode.

ABOO0HZ 168its Reset

B Power Management

o Information

Realtek Audio Console 2 - 7
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2 [T — ——

W Main Main Volume

3 [ e

Microphane Boost

i Speakers [+z0ds |

Microphone Effects

Figure2-6 e

Realtek Audio Noise suppression rediices ambient stationaey noises, |.e. Notebook PC fan, air candition fan nalss, thus imgroving speech Inelligibility and
redissing listenes fatigue.

Console @& on

(M | Cro p h one - Beam forming enhances the vaice signal inside the beam while suppressing noke outside the beam.

Cortana Disabled) & on

AEC removes the acoustic echo coupled int the microphanes fram the loudspeaker outpu thi air

@ or

Default Fermat
Select the sample rate and bit depth 10 be used when rnning in shared made.

48000Hz 168its [

£} Device advanced settings
& Power Management

@ information

2 - 8 Realtek Audio Console



Realtek Audio Console - Device Advanced Settings

Storage Devices, Mouse, & Audio

Device Advanced Settings allows for further configuration of the Connector Set- ﬁ
tings and Recor ding Device.

Realtek Audio Consale
A Main
Playback Devices
4} speakers
Recording Devices

&  Microphone

€ Device advanced settings
B pPower Management

o Infarmation

Connector Settings

Disable front panel popup dialog

@ off

Connector Retasking...

ANALOG
@ Headphone

@ nicin

Recording Device

(®) Tie up same type of input jacks, Le. line-in or microphone, as an input device,

0 Separate all input jacks as independent input devices.

Device Advanced
Settings

For the purposes of re-
cording it is recommend-
ed that you enable
“Separate all input
jacks as independent
input devices” in De-

vice advanced settings.

This will help prevent a
situation where the inter-
nal microphone seems to
be disabled, or where
sound can still be heard
from the speakers even
though the headphones
are plugged into the
headphone jack.

Figure2-7
Realtek Audio
Console - Device
Advanced Settings

Realtek Audio Console 2 - 9
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Touchpad and Buttons/Mouse

The Touchpad is an alternative to the mouse; however, you can also add a mouse to

_ your computer through one of the USB ports. The Touchpad buttons function in
In order to improve pad hth two-butt Mak haveinstalled the Touch
S AT (L5 mucht esame\‘/‘vay asa wcﬂ- utton mouse. esureyou havein e Touch-
sary to keep the surface pad driver (see “ Touchpad” on page 4 - 8).

clean and free of finger- e .
prints and marks etc. Touchpad Sensitivity

Use a soft dry cleaning The mouse button zones at the bottom of the pad are defined by the line at the bot-
cloth to keep the pad tom of the pad, and the left and right buttonsare divided roughly down the middle.
surface clean. Press the | eft button zone for aleft click, and right button zone for aright click ac-
tion.

2N
/Q\

Touchpad Cleaning

Disabling the Pad

Use the Fn + F1 or Con-
trol Center button to dis-
able the Touchpad.

4

Mouse Driver

If you are using an external
mouse your operating system

may be able to auto-configure
your mouse during its installa-
tion or only enable its basic
functions. Be sure to check
the device’s user documenta-
tion for details.

2 - 10 Touchpad and Buttons/Mouse
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Mouse Properties Control Panel e
. . . . 7/ \Y
Y ou can configure the functions from the M ouse control panel in Windows as fol- , ,
lows Disabling the
' Touchpad
1. Right-click the Start Menu g icon.
2. Select Control Panel. If you need to disable
3. Click Mouse (Hardware and Sound > Devices and Printers). the Touchpad for any
4. Click the menu headings tabs to adjust your mouse preferences. reason (e.g. you may

find that when using
@ Mouse Properties X the computer’s internal
keyboard you acciden-
tally trigger the Touch-
pad when resting your
wrists or palms on it)
you can do so by using
Fn + F1 key combina-
tion.

Buttons  Pginters  Pointer Options ~ Wheel  Hardware

Button configuration

Select this check box to make the button on the
right the one you use for pimary functions such
as selecting and dragging.

Doubleclick speed

Double-click the folder to test your setting. i the
folder does not open or close, try using a slower

setting.

Speed: Slow . Fast

ClickLock Figure2-8
[] Tum on ClickLock Settings... Mouse Propel’tieS
Enabl to highlight or d ithout holding d th -
buTEllone.sTy::e: bll'liﬂ;gprec;rs tj’?nagln:;u;e bu;or:-.lg'l'ocr;gas:.n&?:ks?he CO ntrOI Pan el
mouse button again. Buttons

ok ][ Camcat | [ e

Mouse Properties Control Panel 2 - 11
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Figure2-9
Mouse Properties
Control Panels

@ Mouse Properties

Butions  Powiers  Pomior Options  Wheol  Hardware

Schama

‘Wirdows Default (systeen schama)

Savo As.. Uwlato - v iy
4 Enhanca pointar pracision

Customize: .

EE—— | T o

Help Select

Warking In Baciground e Vistay

Busy 0 ES* I oisplay pestor raés

Procision Select +

Tout Soloct I & 1 e poiniee whise typing

[] Enatha pointer sha Use Defaun Browne... h [} Shaw tocation of paintar when | press the CTRL kay
oK Cancal Apoly oK Cancel Apoly

@ Mouse Properties

@ Mouse Properties

Motion

5 Seloct 8 porior spesd:

Butions  Poinisrs  Pomier Options  Wheol  Hardware

Butions  Poinlors  Pomior Opicns Whoel  Hardware

Vartical Scroling
o Flol the wheal ane notch 1o scrolt

() The following number of lines ot o linse:
3

() Ora screon a1 & ime
Hanzontal Scrofing

’] Tift the wha! 1o scroll the following number of
characters at a tima:

3 =

ok ] comem

@ Mouse Properties

Devices:

Hamo

s HID-compliant mouss

& Lognech USE Whoollcuse
& Synaptics SMBus TouchPad

Davica Propertios
Manufscturer:  Merosofl

Loeation:

Davice status:  This devacs = working propsiy.

Butions  Poiniors  Pomior Options Wheo!  Hardware

Typo

Mice oed ather .
Mice ard othar ..
Mice and other ...

on Synagics HID-Comphiant Tauch pad Davica

2 - 12 Mouse Properties Control Panel
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Mouse & Touchpad Devices

Y ou can aso configure the functions from the Mouse or Touchpad control panels
in Devices in the Settings control panel asfollows.
1. Click the Settings item in the Start Menu (or All Settings in the Action Center).

2. Click Devices.
3. Click Mouse or Touchpad.

Settings o x Settings

Windows Settings
% Home
| Find a setting
B D @ s Figure2 - 10
EVICES . .
System Phone Network & Internet WIndOWS Settlngs
Display, notificat Android, i Wi-Fi, airplane mode, VP) 28 Bluetooth & other devic > MOUSG/TOUChpad

=1 Printers & scanners

0 — (-\'
[ p— L I
— =
:j 8= R AF < 0 Mouse >
Personalization Apps Accounts Time & Language
ackground, lock screen ndtall, defaults, optional Yeusr necounts, ermall, syn peech. region, date

E  Touchpad

Typing

A% Pen & Windows Ink

Mouse & Touchpad Devices 2 - 13
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Mouse Settings

Y ou can select the primary mouse button and scrolling options and access Mouse
Properties from Additional mouse options.

£ Home

l Find a setting

Devices

Figure2- 11 |0 voue
Windows Settings B3 Touchpad

Mouse
Typing

&) AutoPlay

A use

Bluetooth & other devices

51 Printers & scanners

% Pen & Windows Ink

Mouse
Select your primary button

Left |

Roll the mouse wheel to scroll

i Multiple lines at a time

Choaose how many lines to scroll each time

Scroll inactive windows when | hover aver them

@ on

Related settings

Additional mouse options

Have a question?
Get help

Make Windows better.

Give us feedback

2 - 14 Mouse & Touchpad Devices
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Touchpad Settings
Y ou can disable the Touchpad by clicking the Touchpad button to turn it off.

Y ou can set the system to automatically disable the internal Touchpad when an ex-
ternal USB point device (e.g aUSB mouse) is attached. Click “L eave touchpad on
when a mouse is connected” to off.

Settings - o x

@ Home Touchpad

I Find a setting ) | Your PC has a precision touchpad.
Touchpad

Devices Q On

Blietoath & atherdevices < Leave touchpad on when a mouse is connected > ]

= Printers & scanners

Figure2-12

Change the cursor speed

0 Mouse ! Windows Settings
Taps Touchpad

E  Touchpad T h d t d ff
Use taps to click, right-click, and select. Turn down the sensitivity if ( ouc pa urned o

Typing they activate while you're typing when mouse

& Pen & Windows Ink Touchpad sensitivity conn ected)

Medium sensitivity
@) AutoPlay —
8 uss Tap with a single finger to single-click

Tap with two fingers to right-click
Tap twice and drag to multi-select

Press the lower right corner of the touchpad to right-click

Mouse & Touchpad Devices 2 - 15
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Touchapd Taps

The Touchpad Sensitivity feature hel ps prevent recognizing taps on the pad by ac-
cident, by recognizing when your palm isresting on it or brushing its surface while
you are typing.

Click in the check box to enable/disable the different gestures or taps on the surface
of the pad to perform specific actions to manipul ate documents, objects and applica-
tions.

Touchpad sensitivity

I 1 Most sensitive
Medium sensitivity -~ e
] High sensitivity
Figure2- 13 z i
Windows Settings Tap with a single finger to single-click SRR
Touchpad e
Sensitivity & Taps Low sensitivity

Tap with two fingers to right-click
Tap twice and drag to multi-select

Press the lower right corner of the touchpad to right-click

2 - 16 Mouse & Touchpad Devices
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Touchapd Scroll and Zoom
Click to enable/disable the two finger scrolling and pinch zooming gesture.

Scroll and zoom

Figure2- 14
Drag two fingers to scroll \p\ Scroll and Zoom/
VA .
Scrolling direction \ \ \J qﬁ SCI’O”IHg Gesture

Down motion scrolls up ~

Pinch to zoom

Thetwo-finger scrolling feature worksin most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
Touchpad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Thetwo-finger pinch to zoom gesture can be used to perform the same function as
a scroll wheel in Windows applications that support CTRL + scroll wheel zoom
functionality. Placetwo fingers on the pad (for best results use thetips of thefingers)
and slide them apart to zoom in, or closer together to zoom out.

i
\ Figure2- 15
‘ _ Zooming Gesture

\

Mouse & Touchpad Devices 2 - 17
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The three-finger and four-finger swipes and taps can be configured for a number
of different functions. Select the appropriate function from the drop-down menu.

Three-fi t
ree-finger gestures Nothing

Swipes

Switch apps and show desktop

Switch apps and show desktop

Switch desktops and show desktop

Search with Cortana

Fi gure 2-16 T Multitasking view Change audio and volume
Three-Finger 4 Showdeskiop
Gestures Nothing
(Swipes & Taps) & Sentchapes Search with Cortana
> Switch apps Action Center
Taps Play/pause W

Middle mouse button R—- ] V¢
)/

Four-finger gestures o
Nathing
Swipes
Switch apps and show desktop
Switch desktops and show deskiop
Switch desktops and show desktop

T Multitasking view Change audio and volume

4 Show desktop

i Mothing
Figure2- 17 e
. th Cortana
FO u T-FI n g er € Switch desktops earch wr
GeStU res =»  Switch desktops AcHon Ceten
(SWipes & Taps) Taps Play/pause
[ Action Center ~ | Middle mouse button

2 - 18 Mouse & Touchpad Devices
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The following is an overview of some of the main gestures you can use with your
Touchpad, however these can be configured from the Touchpad menus. 2
1-Finger 2-Finger 3-Finger 4-Finger
3 Left Click 56 — ~ ~ | Invoke = Invoke
Double-Click R Mg Click 2oe Cortana == Action Center Figure 2-18
Touchpad

Gesture Examples
Maiin 1 ' 5
'—R}}" ES:;[ ~(;)‘J[¥~ Scroll / Pan -_.rl.('m;:;... Multitasking

111 Gestures

o ;
O— | Tap + Slide o Pinch / Zoom

Mouse & Touchpad Devices 2 - 19
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Power Management

Chapter 3. Power Management >
Overview OS Note 3
Power management .

To conserve power, especially when using the battery, your computer power man- functions will vary slight-
agement conserves power by controlling individual components of the computer | |y gepending on your
(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system.

» The Power Sources

* Turning On the Computer

» Power Plans

» Power-Saving States

» Configuring the Power Buttons
» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OSto set devicesinto low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1
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4

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and connect the AC power cord to the AC/
DC adapter (make sure you use the adapter when first setting up the
computer, as to safeguard the computer during shipping, the battery will be locked
to not power the system until first connected to the AC/DC adapter).

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see “ Battery FAQ” on page 3 - 21).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 16.

3 - 2 The Power Sources
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Turning On the Computer

Now you are ready to begin using your computer. To turnit on simply pressthe pow-

er button on the front panel.
When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use

Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.

4

Power Button as Stand by or Hibernate Button

You can use the OS's “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).

Turning On the Computer 3 - 3
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Shutting the Computer Down

Note that you should always shut your computer down by choosing the Shut down
command asthiswill help prevent hard disk or system problems. Use the Power
item in the Start M enu and select Shut down.

Y ou can also use the context menu (right-click the Start Menu &g icon or pressthe
Windows logo gg@ + X key combination) to Sign out, Sleep, Hibernate, Shut
down, and Restart.

If you want to add Hibernate/Sleep to the Power Menu see “ Adding Hibernate/
Sleep to the Power Menu” on page 3 - 10.

Figure3-1
Shut Down/Restart

3 - 4 Shutting the Computer Down



Power Plans

The computer can be configured to conserve power by means of power plans (Con-
trol Panel > Power Options). Y ou can use (or modify) an existing power plan, or
create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration optionsin Advanced Settings.

@ Edit Plan Settings - B X 3® Power Options * X
t X &l Contred Panel ierms + Power Options. » Ede Plan Settings v O arch Centrol Pa )
o i 2 Advanced settings
Change settings for the plan: Balanced Select the power plan that you want te customize, and
Choose the sheep and display settings that you want your computes to use \13 then choose settings that reflect how you want your
computer to manage power.
j On battery £ Pluggedin
| Balanced [Active] &
B T off the duply: 5 minutes | 10 minutes = Hard disk fat
= Turn off hard disk after
W Putthe computerto sleep: | 15 memden v | mie - On battery (Minutes): :

Plugged in: 20 Minutes
) Intemet Explorer

msktcp background settings

5 Wireless Adapter Settings

@ Sleep

0 [ cancel ] USB settings

‘ 5] Intel(R) Graphics Settings

1 Drser b tbnne and lid

Power Management

4

Resuming
Operation

See Table3 - 1, on
page 3 - 11 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-2
Power Plan
Advanced Settings

Power Plans 3 - 5
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High perfor mance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

' = % Creste a Power Plan - [m] x
Jﬁ Power Options @

Figure3-3 & 5 « 4 |« AlCon
Power Plans

- ~ 4 39 « PowerOptions > Create a Power Plan ~ @ | Search Control Panel -]

Create a power plan

CartroiPanalHorie Start with an existing plan and give it a name.
(@) Balanced (recommended)

Automatically balances performance with energy consumption on capable hardware.
Choose what the power
buttons do (O Power saver
Saves energy by reducing your computer's performance where possible,

Choose what closing the lid

does () High performance

Favors performance, but may use more energy.

Create a power plan

L—*j Chooze when to turn off the Plaiiiaiig
d|5p|a}. My Custom Plan 1
% Change when the computer
e

3 - 6 Power Plans



Power-Saving States

Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Windows 10 uses the Sleep, Hiber nate and Shut Down power-saving
states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last | eft
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.

.|
Power-Saving States 3 - 7
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Wake On LAN
Support

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows.

If you require your com-
puter to wake up from
network activity in Win-
dows then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows.
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Figure3-4
Power Button &
Start Menu Power

Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last |eft off within seconds. Y ou should
put your mobile PC into Hiber nate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hiber nate to the
Power Menu see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down

Y ou should Shut down the computer if you plan to install new hardware, plan to be
away from the computer for several days, or you do not need it to wake up and run
ascheduled task. Returning to full operation from Shut down takeslonger than from
Sleep or Hibernate.

Task Manager

Sleep

Hibernate et Sign out

File Explorer Sleep

Shut down

Search Hibernate
Restart

Run Shut down

Shut down or sign out A

Desktop

3 - 8 Power-Saving States



Configuring the Power Buttons

The power/sleep button (Fn + F12 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttonsdo on

the left menu in Power Optionsto bring up the menu.

E System Settings

Define power buttons and turn on password protection

« v E < All Control Panel ltems » Power Options » System Settings v @  Search Control Panel

Choose the power settings that you want for your computer. The changes you make to the settings on this

page apply to all of your power plans.

&) Change settings that are currently unavailable

Power and sleep buttons and lid settings

j On battery A9 Pluggedin
@ When | press the power button: | Sleep ~| |Sleep
@ When | press the sleep button: Sleep V| |Sleep
{h When | close the lid: Sleep v | |Sleep

Shutdown settings
Turn on fast startup {recommended)
This helps start your PC faster after shutdown, Restart isn't affected. Learn More

Sleep
Show in Power menu.

Hibernate
Show in Power menu.

Lock
Show in account picture menu.

Save changes

Cancel

Power Management

4

Password
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-5
Power Options
Define Power
Buttons

Configuring the Power Buttons 3 - 9
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Figure3-6
Power Options
Define Power
Buttons - Shutdown
Settings

Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Slegp to the Power Menu as follows.

1. Go to the Power Options (Hardware and Sound) control panel.
2. Click “Change Settings that are CUrrentIy unavailable” ) Change settings that are currently unavailable .
3. Click Choose what the power buttons do.
4. Click to put a check in the Hibernate/Sleep box under Shutdown settings.
5. Click Save Changes and close the control panel.
3B System Settings - [m} x
« v 4 3@ « All Control Panel ltems > Power Options » System Settings w| @ | Search Control Panel p

Define power buttons and turn on password protection

Chaose th  for your computer. The changes you make to the settings on this

o all of your power plans.

&) Change settings that are currently unavailable

Shutdown settings

@ When | press the power button:

@ When | press the sleep button:
% When | close the id:

Shutdown settings

Turn on fast startup (recommended)
This helps start your PC faster after shutdown. Restart isn't affected.

[ Sleep

Show in Power menu,

[A Hi

Turn on fast startup (recommended)

This helps start your PC faster after sh how in Power menu.
Sleep
Show in Power me Lock

Hibernate
Show in Power menu.

Lack

Show in account picture menu.

Show in account picture menu.

Save changes Cancel

3 - 10 Configuring the Power Buttons
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Resuming Operation
Y ou can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F12 key combo).

Power Status Icon /(1) Color To Resume
Table3-1
Power Off Off Press the Power Button Resuming
Press the Power Button Operation
Sleep Blinking White Press the Sleep Button (Fn + F12 Key
Combo)
Off (battery)
Hibernate Press the Power Button
Orange (AC/DC adapter)
Display Turned Off White Press a Key or Move the Mouse/Touchpad
Power Button i )
Closing the Lid
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power If you have chosen to
button for longer than this will force the computer to shut down). send the computer to
Sleep when the lid is
closed, raising the lid

will wake the system up.

Configuring the Power Buttons 3 - 11
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Ctrl + Alt + Delete Key Combination

YoucanusetheCTRL + ALT + DEL key combination from almost any of the Win-

dows 10 interfaces/Apps to bring up a full-screen displaying L ock, Switch User,
Sign out, Change a password and Task Manager options. If you click the Power

icon in the lower right corner of the screen a power management option menu ap-

pearsto display Sleep, Shut down, and Restart.

Figure3-7
Ctrl + Alt + Delete
Menu

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

3 - 12 Configuring the Power Buttons
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Settings Menu Power Controls

The Settingsitem in the Start Menu (or viathe Action Center) givesyou accessto

anumber of power settings control panelswhich enable you to quickly adjust power
options. Click System to access the menu including the power option settings.

— —
B Calculator Setings

Calendar i .
Windows Settings
Camera

[l Connect

Settings O Cortana

= i S
System _ Devices Fhone MNetwork & Intemet
Figure3-8
Settings
= R <
4 = AT
Apps Accounts Time & Language

Personalization

Settings Menu Power Controls 3 - 13
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Saver

Battery in Settings will display the battery level, and by clicking Battery usage by
app you can see the current state of battery usage by application etc. The Battery
saver can be level can be adjusted to be turned on if the battery level falls below a
certain level to limit background activity and push notifications.

o Settings =
uglHore Battery
Find a setting 0 Qverview Get more battery life

To see which apps are draining you
System batt: ect Battery usage by apg
72 O/ You can also save battery by
, (0] lowering screen brightness in
& Display Display settings.
Estimated time remaining: 6 hours 7 minutes Open the Display scttirigs
99) Sound

See which apps are affecting your battery life

[] Notifications & actions Have a question?

Battery notifications Get help
J) Focus assist
No notifications f

FI gure 3 - 9 & Power &sleep Make Windows better
Set“ngs > Ba'['[el’y Give us feedback
| = eattery Battery saver
Saver

= Storage Extend battery life by limiting background activity and push
notifications when your device is low on battery.

L@ Tablet mode
Turn battery saver on automatically if my battery falls below:

Ht Multitaski

T Multitasking = 90%
= Projecting to this PC attery saver status until next charge
> Shared experiences

3 - 14 Settings Menu Power Controls



Power & Sleep
Power & sleep gives you quick access to Screen and Sleep settings. Click Addi-
tional power settingsto go to the main power options control panel.

o

&

Settings

Home

Find a setting

System

jmm}

9

O

o &

L]

.|
Settings Menu Power Controls 3 - 15

Display

Sound

Notifications & actions

Focus assist

Power & sleep

Battery

Storage

Tablet mode

i Multitasking

Projecting to this PC

Shared experiences

Power & sleep
Screen
On battery power, turn off after

5 minutes W

When plugged in, turn off after

10 minutes v

Sleep
On battery power, PC goes to sleep after

| 15 minutes v |

When plugged in, PC goes to sleep after

| 30 minutes v

Save energy and battery life

Set how quickly your screen goes to
sleep when you take a break from
your PC.

Get more info about saving PC
energy

Related settings

Additional power settings

Have a question?

Get help

Make Windows better

Give us feedback

Power Management

Figure3- 10
Settings > Power &
Sleep
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Power Slider

The Power Slider (click
the battery icon in

the notification area) lets
you trade performance
Vs battery life, by
choose the power mode
you want (see over).

Figure3- 11
Battery Icon
(Notification Area) &
Battery Advanced
Settings

Battery Information

Follow these simple guidelines to get the best use out of your battery.

Battery Power

Y our computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. Y ou can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3-3o0n page3-6).

Click the battery icon in the notification areato see the current battery level and
charge status. You can also adjust the Power Slider towards Best battery life or
Best performance, or click Battery Settingsto quickly adjust battery settings).

() 100% Fully charged

Power mode (plugged in): Better performance

Balanced [Active]

3 - 16 Battery Information
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Power Slider Settings

4

Battery Saver

Better Best

Battery Saver Better Battery Performance Performance

Note that some Win-
dows features and back-
ground applications may
behave differently, or
may be blocked, when
the system is in Battery
For DC Only For AC & DC Saver mode (check with
Microsoft for details).

i} 5% =} 94%

n cle {on battery): Battery saver Pk attery): Better battery

m 93%

de (on battery): Best performance

Slightly Favors

Lower Power than Favors Performance

Lowest Power Setting Default Settings Performance Over Over Power
Power
, Table3- 2

Windows Features .

Throttled & Screen Default Position Power Slider
Brightness Reduced Settings & Notes

Auto Enabled at 20% of
Battery Capacity

Battery Information 3 - 17
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Conserving Battery Power

Z » Useapower plan that conserves power (e.g Power saver), however note that
Windows Mobility this may have an affect on computer performance.
Center

The Windows Mobility

* Lower the brightness level of the LCD display. The system will decrease LCD
brightness slightly to save power when it is not powered by the AC/DC adapter.

Center control panel . . .
provides an easy ppoim * Reduce the amount of time before the display is turned off.
of access for information .

on battery status, power
plans used and wireless

not being used.

device status etc. .
ExpressCards etc.
ﬁg Windows Mobility Center
Display A

&] brightness ~ =-"})‘ [ Mute

(| ]

Brightness Volume
.Figure 3 - 12 :J;jﬂs[f:rcm i @iy Notpresenting

Windows Mobility
Center Sync settings Turn on
(Control Panel) , :

Sync Center Presentation Settings

Close wireless, Bluetooth, modem or communication applications when they are

Disconnect/remove any unnecessary external devices e.g. USB devices,

= X
Fully charged No display
ﬁ.ﬂ (100%) connected
Balanced w Connect display

Battery Status External Display

)
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Battery Life "

/
Battery life may be shortened through improper maintenance. To optimize thelife /f,l\
and improve its performance, fully dischar ge and rechar ge the battery at least Battery Removal
once every 30 days.

Note that the built-in
battery is not user re-
movable. Removing the
battery will violate the

We should not remove the built-in battery yourself (see sidebar).

New Battery terms of your warranty.
Always compl etely dlscha_rge, then fully charg(_e, anew battery (see” Battery FAQ” it you need to remove
on page 3 - 21 for instructions on how to do this). the battery for any rea-
son, please contact your
Recharging the Battery with the AC/DC Adapter distributor/supplier  for

The battery pack automatically recharges when the AC/DC adapter is attached and (UHREHRTOMmAton:

plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge timeis less. Refer to “LCD Panel
Open - Model B” on page 1 - 7 for information on the battery charge status, and to
“Battery FAQ” on page 3 - 21 for more information on how to maintain and prop-
erly recharge the battery pack.

.|
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Proper handling of the Battery Pack

ﬂ‘ * DO NOT disassemble the battery pack under any circumstances
Caution * DO NOT expose the battery to fire or high temperatures, it may explode

5 o * DO NOT connect the metal terminals (+, -) to each other
anger of explosion if

battery is incorrectly re-
placed.

2AN\Z
I

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being

dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to alow battery. Don't

turn off the computer even if amessage indicates the battery iscritically low, just let 3
the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.

2. Create a power plan for discharging the battery and set all the options to Never.

3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

L4

B ‘ .- . ‘
P S’
> e Figure3- 13
Power Plan Create
B Edt Plan St - o Ed

« T o AllCoetiolPacel hems + Power Options + Edt Flan Settings

Change settings for the plan: Discharge Bartery

Checse the sitep and driplay sefengs that yeus want yeor compter 1o s
l O hateery 8 Pluggedm
1D Turm ulf the disglay Hever ¥ o

W Put the compter o deeps | Hover | Hever %
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

35 Pawer Options ? X
3 Advanced settings

\(e OSelect the power plan that you want to customize, and
lg

then choose settings that reflect how you want your
computer to manage power.

Discharge Battery [Active] v
Figure3-14 "
Power Options = Low battery level
. On battery: 0%
Advanced Settings - Plugged n: 0%
Battery ) Critical battery level

On battery: 1%
Plugged in: 1%

= Low battery notification
On battery: On
Plugged in: On

=11 nuss hattens artinn

Restore plan defaults

Cancel Apply

* Low battery level = 0%

» Critical battery level = 1%

» Low battery action = Do Nothing
* Reserve Battery Level = 0%
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.

How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Chapter 4: Drivers & Utilities

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most available op-
erating systems haven’t built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install

You will need to attach an external optical CD/DVD devicedriveto install the
driversfrom the Device Drivers & Utilities + User’s Manual disc. The disc con-
tains the drivers and utilities necessary for the proper operation of the computer. Ta-
ble4 - 1, on page 4 - 4 lists what you need to install and it is very important that
thedriversareinstalled by the method outlined in thischapter, and in the or der
indicated. Note that the information on the following pagesis for Windows 10 (64-
bit) only.

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, Bluetooth & WLAN
Combo, Intel Technology, Sound Blaster Cinema and 4G modules are provided
in“Modules’ on page6 - 1.

. |
What to Install 4 - 1

Drivers & Utilities

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
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Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
Click the message “Tap to choose what happens with this disc.”

Click Run autorun.exe.
Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

PN

() Drivers Installer

Figure4 - 1- Drivers Installer Screen 1

4 - 2 Driver Installation
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Drivers & Utilities

Check the driver installation order from Table 4 - 1, on page 4 - 4 (the drivers must be installed in this order)
which is the same as that listed in the Drivers Installer menu below.

Click to select the driver you wish to install, (you should note down the drivers as you install them).

Follow the instructions for each individual driver installation procedure as listed on the following pages.

) Drivers Installer - e
i -

Please follow steps from top to
bottom in order to install drivers.

Figure4 - 2 - Install Drivers

Driver Installation 4 - 3
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Win 10 (64-bit) Driver Page # Win 10 (64-bit) - Optional Items Page #
Chipset Page 4 -7 Setting Up SATA Mode (Optane™ or AHCI) Page 6 - 2
Video (VGA) Page 4 -7 Wireless LAN Module Page 6 - 10
NVIDIA Video (VGA) Page 4 -7 Fingerprint Reader Module Page 6 - 14
NVIDIA Apps Page 4 - 8 Bluetooth & WLAN Combo Module Page 6 - 17
LAN Page 4 -8 Intel® Software Guard Extensions Driver Page 6 - 23
Card Reader Page 4-8 il:t;\e:_(i@cfzgrpgjpts;géarggdze)chnoIogy (required for hard disks Page 6 - 24
Touchpad Page 4 -8 Sound Blaster Cinema 5 Page 6 - 31
Intel® HID Filter Driver Page 4 -9 Intel® Speed Shift Technology Driver Page 6 - 37
Control Center Page 4 -9 PC Camera (no driver installation required) Page 6 - 38
MEI Driver Page 4 -9 Trusted Platform Module (no driver installation required) Page 6 - 44
Audio Page 4 -9 4G Module (no driver installation required) Page 6 - 50

All drivers provided are for the Windows 10 (64-bit) operating system.

Table 4 - 1 - Driver Installation
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.

4 - 4 Driver Installation



Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Check for updates (Settings > Update & security >
Check for updates) in order to get al the latest secu-
rity updatesetc. (all updateswill includethe latest hot-
fixes from Microsoft). See “Windows Update” on
page 4 - 10 for instructions.

Drivers & Utilities

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs icon (Programs > Unin-
stall a program). Click to select the driver (if it is not
listed see below) and click Uninstall, and then follow
the on screen prompts (it may be necessary to restart
the computer). Reinstall the driver as outlined in this
chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go tothe Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Devices and Printers > Device
Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

Driver Installation 4 - 5
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
aready received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the install ation proce-
dure.

4 - 6 Driver Installation
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Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON (i.e. the system is not in Airplane Mode) before
installing the appropriate driver.
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Driver Installation Procedure 8. A list of apps being downloaded will pop-up.
Insert the Device Drivers & Utilities+ User’'sManual 9. To prioritize the driver you can click Pause all
disc and click Install Drivers (button). and pause the other drivers download queue.

10. Click on Intel Graphics Control Panel and
click on theresumeicon O to download the
driver.

11. When finished the Intel Graphics Control
Panel will appear in the Windows Sart menu.

Chipset

1. Click Llnstall Chipset Driver > Yes.

2. Click Next > Accept > Install.

3. Click Restart Now to restart the computer.

Video (VGA) Note: After installing the video driver go to the Dis-
1. Click 2.Install VGA Driver > Yes. play/Display Settings control panel to adjust the vid-
Click Next > Yes > Next > Next. €0 settings to the highest resolution.

NVIDIA Video (VGA)

1. Click 3.Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to
accept the terms of the license agreement.

3. Click Next.

4. Restart the computer and run the application
again after restart.

Go to the Microsoft Store to download the
NVIDIA Control Pandl.

2.

3. Click Finish to restart the computer.

4. Intel Graphics Control Panel will download
but you will need to have aworking internet
connection.

5. Click the Sart menu in Windows to access the
Microsoft Store App tile under Explore.

6. ClicktheSigninicon &, and select Down-

loads and updates. 5
7. Click Check for Updates. '

|
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Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 settings to the highest resolution.

NVIDIA Apps

1. Click 4.Install NVIDIA Apps> Yes.

2. Click AGREE AND CONTINUE (button) to
accept the terms of the license agreement.

3. Click Next.

Click Close to complete the installation.

5. After dl thedrivers have been installed (an
internet connection is required) run the
NVIDIA GeForce Experience by clicking the
desktop icon kg (or App).

E

LAN

Note: If the computer enters a deep sleep mode during
installation, you will be prompted to plug in a network
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the system and re-
install the LAN driver.

1. Click 5.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

Card Reader

1. Click 6.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 7.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license, and then
click Next.

4. Click Finish > Restart Now to restart the com-
puter.

4 - 8 Driver Installation



Intel® HID Filter Driver

Click 8.Install HID Filter Driver > Yes.
Click Next.

Click Yesto accept the license.

Click Next.

Click Finish to restart the computer.

SAREIE A o

Control Center

1. Click 9.Install Control Center AP > Yes.

2. Click Next > Install.

3. Click Finish to restart your computer (see
Appendix B).

MEI Driver

1. Click 10.Install MEI Driver > Yes.

2. Click Next.

3. Click the check box to accept the license and
then click Next.

Click Next.

Click Finish.

oA~

Drivers & Utilities

Audio

1.

2.
3.
4

© N

10.

11.

Click 11.Install Audio Driver > Yes.

Click Next.

Click Finish to restart the computer.

Realtek Audio Control Panel will download 4
but you will need to have aworking internet
connection.

Click the Start menu in Windows to access the
Microsoft Store App tile under Explore (see
Figurel- 23 on pagel- 32).

Click the Sign inicon &, and select Down-
loads and updates.

Click Check for Updates.

A list of apps being downloaded will pop-up.
To prioritize the Realtek audio driver you can
click Pause all to pause the download queue.
Click on Realtek Audio Control and click on
the resumeicon (O to download the driver.
When just installed the Realtek Audio Con-
sole will appear in the Windows Start menu.

Driver Installation 4 - 9
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Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, gect
the Device Drivers & Utilities + User’s Manual disc
and thenreinsert it (or double-click thedisciconinMy
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

It is recommended that you install the Sound Blaster
Audio application (see“ Sound Blaster Cinema5” on
page6 - 31) and Intel Rapid Storage Technology
driver (see “Intel® Rapid Storage Technology” on
page 6 - 24 - required for AHCI or Optane mode).

4 - 10 Driver Installation
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Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1.
2.

3.
4

Go to the Control Panel.

Click Windows Update (System and Security/
Security).

Click Check for updates (button).

The computer will now check for updates (you
need to be connected to the internet).

Click Install now (button) to begin checking for the
updates.

Click Install updates (button) to install the
updates.
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Optional Drivers

See the pages indicated in Table 4 - 1, on page 4 - 4 for the driver installation procedures for any modules in-
cluded in your purchase option.

Please follow steps from top to
bottom in order to install Option
drivers.

Figure 4 - 3 - Optional Drivers Installer Screen
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.

Driver Installation 4 - 11
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BIOS Utilities

Chapter 5: BIOS Utilities -

/ \Y

BIOS Screens

Overview
. . L : . Note that the BIOS
This chapter gives abrief introduction to the computer’s built-in software: sfreeens . pictu?ed on
these pages are intend-
Diagnostics: The POST (Power-On Self Test) ed for guidance in set-

ting up your system'’s
BIOS.

Configuration: The Setup utility
If your computer has never been set up, or you are making important changestothe B =ee e e o
system (e.g. hard disk setup), then you should review this chapter first and note the BT ERE S ERRETRE
original settings found in Setup. Even if you are abeginner, keep arecord of the set-  JFEUCREUEICIEGEEE
tings you find and any changes you make. This information could be useful if your AU EaSE e
- screens may appear
System ever needs servicing. slightly different from
those pictured on these

There is one general rule: Don’t make any changes unless you are sure of what you  JElkEs
aredoing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service

representative.

. |
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The Power-On Self Test (POST)

If you enable the Boot-time Diagnostic Screen in the Setup Utility, each time you
turn on the computer the system takes afew seconds to conduct a POST, including
aquick test of the on-board RAM (memory).

BIOS Settings
Warning

Incorrect settings can ) ) ) )
U s e ool Asthe POST proceeds, the computer will tell you if thereis anything wrong. If there

malfunction. To correct isaproblem that prevents the system from booting, it will display a system summary

mistakes, return to Set' and promp‘t you to run %tup'
up and restore the Opti-

WIEECERPEERLERIIGUEE | f there are no problems, the Setup prompt will disappear and the system will load
SES= the operating system. Once that starts, you can't get into Setup without rebooting.
UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot op-
tions.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.

The Power-On Self Test (POST) 5 - 3
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Opti-
mized Defaults with
<F3>.

The Setup Utility

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup; the F2 on screen will be highlighted to illustrate that the system is
processing the request) during the POST (or press F7 for boot options). If you get a
“Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7.

5 - 4 The Setup Utility
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Setup Screens
The following pages contain additional advice on portions of the Setup. Along the Z

top of the screen is a menu bar with menu headings. When you select a heading, a Setup Menus
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

The Setup menus
shown in this section are

for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

Figure5-1
Navigation Menu

If these tools are confusing, press F1 to call up a General Help screen, and then use
the arrow keys to scroll up or down the page.

Theltem Specific Help on the upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow - next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

The Setup Utility 5 - 5



BIOS Utilities

Main Menu

Aptio Setup Utility — Copyright (C) 2018 American Megatrends Inc.

Figure5-2
Main Menu

System Date:

SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

5 - 6 Main Menu
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OffBoard SATA/NVme Controller Configuration (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of any devices on the
off board SATA/NVme Controller if applicable.

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will also change
these settings. Some applications may also alter datafiles to reflect these changes.

ME FW Version/SystenVExtended Memory (Main Menu)
Thisitem containsinformation on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series/BIOS Revision/KBC/EC firmware Revision/Mac Address (Main
Menu)

This item contains information on the BIOS version, and the identifier address for
the device on anetwork, and is not user configurable.

. |
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Advanced Menu

Aptio Setup Utility — Copyright (C) 2018 American Megatrends Inc.

Figure5- 3
Advanced Menu

p Advanced Chipset Control

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to enable/disable FlexiChar ger (see page5 - 9), SW
Guard Extensions, VT-d and Fast Boot.
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FlexiCharger (Advanced Menu > Advanced Chipset Control)

The sub-menu here allows you to enabl e/disable the FlexiChar ger . The FlexiCharg-
er may be set to automatically start charging your battery when the battery reaches
acertain capacity level (e.g. you could start the battery charge level at 40%).

Seethesidebar warningfor information on runningthe FlexiChar ger for an ex-
tended period asthisis not recommended.

Aptio Setuwp Utility — Copyright (C) 2018 American Megatrends Inc.

FlexiCharger

Software Guard Extensions (Advanced Menu > Advanced Chipset Control)
Intel provides SGX, which isaset of instructions allowing user-level code a degree
of security, and privacy, from the operating system. Make sure that SW Guard Ex-
tensions is Enabled here, and then install the driver (see “ Intel® Software Guard
Extensions Driver” on page 6 - 23) to support this.

BIOS Utilities

FlexiCharger
Warning

If you leave the FlexiCh-
arger continuously "En-
abled” for a period of
three months or more,
the battery meter's read-
ing accuracy will deteri-
orate.

To reset this, set the
FlexiCharger to "Dis-
abled", and then allow
the battery to completely
discharge (see

before enabling the
function again.

Figure5-4
Advanced Chipset
Control >
FlexiCharger
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4

Intel® Optane™

Intel® Optane™ is a combi-
nation of a compatible
memory device and Intel
Rapid Technology soft-
ware. This combination is
designed to speed up your
system performance.

Contact your distributor or
supplier to see if your sys-
tem supports this technolo-
ay.
SATA Mode
Selection

If you have installed the
Windows OS with either
AHCI or Intel RST (Op-
tane) mode enabled, DO
NOT disable the set mode
(if you wish to disable the
set mode you will need to
reinstall the Windows OS).

VT-d (Advanced Menu > Advanced Chipset Control)

Enable/disable Intel® Virtualization Technology for Directed 1/0 (VT-d) from
this menu. This extends Intel's Virtualization Technology (VT) by providing hard-
ware assists for a virtualization solution.

Fast Boot(Advanced Menu > Advanced Chipset Control)
Use this menu item to enable/disable the Fast Boot option, which when enabled,
helps reduce the time it takes to boot the computer.

SATA Mode (Advanced Menu)

The SATA (Serial ATA) control is configured to operatein AHCI (Advanced Host
Controller Interface) mode or in Intel RST Premium... (for Intel®@ Optane™)
mode.

The SATA M odeshould beset BEFORE installing an oper ating system, and after
you have backed up all necessary filesand data (see sidebar). See” Setting Up SATA
Mode (Optane™ or AHCI)” on page 6 - 2 for details. Make sure you install the I n-
tel Rapid Storage Technology application if you have set the SATA Modeto I ntel
RST Premium..., or to AHCI (see“IRST Driver Installation” on page 6 - 24).

If you wish to change your SATA mode to/from AHCI/Intel RST (Optane) mode
note that doing so may prevent your operating system from booting, and may require
areinstall of the OS. If you do wish to change the SATA mode then backup any nec-
essary dataon your hard disk(s) asyou will need wipe the disks clean in order to pre-
vent system problems.

. |
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Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

Package C Sate Limit (Advanced Menu)

Y ou can manually set the CPU C-State limit here (it is set to Auto by default. A C-
State is a power mode for the CPU, and the CPU can be commanded to enter alow-
power mode in order to save energy.

The CPU has several such power modes or C-States which start at CO, and thisisthe
normal CPU operating mode (the CPU isturned on 100%). The higher the C number
the deeper the CPU sleep (mode more signals and circuits will be turned off) and
more the time the CPU will take to go back to CO mode and wake-up.

. |
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Security Menu

Aptio Setup Utility — Copyright (C) 2018 American Megatrends Inc.

4

Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Secure Boot Mode [Standard]

Secure Boot Mode
standard
Custom

Figure5-5
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
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Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Note: You can only set the user password after you have set the supervisor pass-
word.

Set User Password (Security Menu)

Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode.

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)

Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”.

BIOS Utilities

NG
A&

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled”), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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BIOS Utilities

Figure5-6
Security -
Secure Boot
(Key Management)

Secure Boot Control (Security Menu)

Secure Boot Control prevents unauthorized operating systems and software from
loading during the startup process. Secur e Boot is available as amenu option if you
have enabled UEFI Boot (see“Boot Menu” on page 5 - 16). Enabling Secure Boot
will bring up the Secur e Boot M ode menu to enable you to configure Secure Boot
as Standard (with a fixed secure boot policy), or Custom (which enables you to
make changes to the Key M anagement database).

Aptio Setup UOtility — Copyright (C) 2018 American Megatrends Inc.

P Restore Factory Keys
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TPM Configuration (Security Menu)

This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press En-
ter to accessthe sub-menu. Press Enter to accessthe Security Device Support menu
and select Enableto support TPM. Y ou can select Pending oper ation, and then se-
lect TPM clear to clear existing TPM information in order to reset the TPM (see
“Trusted Platform Modul€e’ on page 6 - 44 for details).

Aptio Setup Utility — Copyright (C) 2016 American Megatrends Inc.

Security Device Support

Figure5-7
Security Device
Support
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Boot Menu

Setup Utility — Copyright (C) 2018 American Megatrends Inc.

. Boot
Figure5-8
Boot Menu

Boot Option #1 [Windows Boot Manager
(P2: TOSHIBA
MQOI1ABFO50) ]

BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-

ject to constant change
and revision, therefore

your computer’'s actual A . .
A When you turn the computer on it will look for an operating system (e.g. Windows

slightly different from 7) from the devices listed in thismenu, and in this priority order. If it cannot find
LRSSl the operating system on that device, it will try to load it from the next device in the
pages. order specified in the Boot Option Priorities.

. |
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Boot Option Priorities (Boot Menu)

Press Enter to select the Boot Option # and use the arrow keys to select any device
in order to move its boot priority up and down the list (the selected device will be
highlighted in white).

UEFI Boot (Boot Menu)

Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack item will be enabled as an option un-
der UEFI Boot.

UEFI Boot is enabled for your system by default. It is recommended that you
keep UEFI Boot enabled for the Windows oper ating system.

BIOS Utilities

Boot Menu 5 - 17
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Exit Menu

Aptio Setup Utility — Copyright (C) 2018 American Megatrends Inc.

Figure5-9 -
Exit Menu

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to its original state, and erase any previous changes you have madein
aprevious session.

I
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Chapter 6: Modules

Overview

This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

» Setting Up SATA Mode (Optane™ or AHCI)
* WirelessLAN Module

* Fingerprint Reader Module

Bluetooth & WLAN Combo Module
Intel® Software Guard Extensions Driver
Intel® Rapid Storage Technology

Sound Blaster Cinema 5

Intel® Speed Shift Technology Driver
PC Camera

e Trusted Platform Module

* 4G Module

Overview 6 - 1



SATA Mode
Selection

The SATA mode selec-
tion should be made be-
fore installing your
operating system.

DO NOT change your
selected SATA mode
unless you intend to re-
install your operating
system. Make sure you
have backed up all your
data before doing so.

See

Setting Up SATA Mode (Optane™ or AHCI)

AHCI Mode

Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). Make sure you in-
stall the Intel® Rapid Storage Technology application to support your HDDg/
SSDsin AHCI mode (see “ Intel® Rapid Storage Technology” on page 6 - 24).

Intel® Optane™

Intel® Optane™ isacombination of acompatible memory device and I ntel Rapid
Technology software. This combination is designed to speed up your system per-
formance by caching boot data, executables, frequently accessed data and system
page files to an non volatile, low latency Intel® Optane™ SSD.

Contact your distributor or supplier to seeif your system supports this technology.

Intel® Rapid Storage Technology Application

Make sure you install the Intel® Rapid Storage Technology application if you
have set up your system in Intel RST Premium (for Intel® Optane™) mode (see
“Intel® Rapid Storage Technology” on page 6 - 24).

After setting the SATA modeto Intel® Optane™ and installing the I ntel® Rapid
Storage Technology application, DO NOT uninstall the Intel® Rapid Storage
Technology application.

6 - 2 Setting Up SATA Mode (Optane™ or AHCI)



Intel® Optane™ Setup Procedure

Afterinitial setup make sureyouinstall thelntel Rapid Storage Technology driver

- see”|RST Driver Installation” on page 6 - 24). Intel® Optane™
Support

See also “ Clearing Intel® Optane™” on page 6 - 7 (however backup up any neces-
sary filesand data befor edeleting an Optane setup, asdoing so will result intheloss
of all data on the volumes).

Note that Intel® Op-
tane™ requires the in-
stallation of an SSD in
the correct slot in your
computer, and will be

You need to setup Intel® Optane™ before installing your Windows 10 operating

system, and you will need to prepare the following in order to do so. supported by certain
CPU types only.

* The Microsoft Windows 10 OS DVD. As the removal of any

* An attached external DVD drive. cover(s) and/or screw(s)

* AnIntel® Optane™ SSD installed in your system. may violate the terms of

* The Device Drivers & Utilities+ User’s Manual disc. your warranty, please
contact your distributor/

supplier for further infor-

Start-up your notebook computer and press <F2> to enter the BIOS. LI E0E LSl s
Go to the Boot menu, select UEFI Setting and press <Enter> (see page 5 - 17). Optane hardware setup.
Set UEFI Boot to “Enabled”.

Press <Esc> to exit the menu and go to the Main menu.

Select OffBoard NVMe Controller Configuration and press enter to check that
an Intel® Optane™ SSD is present.

Press <Esc> to exit the menu and go to the Advanced menu.

aprwNE

o
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7. Select SATA Mode (see page 5 - 10), press <Enter> and select “Intel RST
Premium With Intel Optane System Acceleration.”.

Flgure 6-1 SATA Mode:
SATA Mode AHCT Mode
Selection (BlOS) Intel RST Premium With Intel Optane System Acceleration

8. Press <F4> and <Yes> to “Save Changes and Reset".

9. As the computer restarts press <F2> to enter the BIOS again.

10. Go to Intel(R) Rapid Storage Technology (Advanced menu) and press <Enter>.

11. . (Note this item only appears after you have restarted and accessed the BIOS
b again after having set SATA Mode to Intel RST Premium.)

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

Figure6- 2
Intel(R) Rapid
Storage Technology
(Advanced Menu)

p PCIe 1.0 INTEL MEMPEKIW016GA FUBT704300GR0O16D, 13.4GB

12. If you are reinstalling a system that has previously been setup in Intel RST
Premium mode, make sure you have cleared the Intel Optane Memory (see
“Clearing Intel® Optane™” on page 6 - 7).

6 - 4 Setting Up SATA Mode (Optane™ or AHCI)



13.

14.
15.
16.

17.
18.
19.
20.
21.
22.
23.

24,

Press <F4> and <Yes> to “Save Changes and Reset”, however ensure that the
condition in the bulleted point below is met before doing so.

Make sure the Windows 10 OS DVD isin the attached DVD drive, as the com-
puter starts up it will automatically boot from the Windows 10 OS DVD (you
will be prompted to press a key to boot from the DVD).

Press <F7> as the computer starts up to bring up the boot device menu.

Select the DVD drive containing the Windows 10 OS DVD and press <Enter>.
Press a key at system startup to begin installing Windows from your Microsoft
Windows 10 disc.

Click Next > Install Now to continue installing the operating system as normal
(see your Windows documentation if you need help on installing the Windows
0S).

Select Custom: Install Windows only (advanced).

It is recommended that you select and then delete existing partitions.

Click New to create a partition for Windows.

It is very important to make sure that when you create the partition, to leave at
least a minimum of unallocated space of 5SMB (see sidebar).

Follow the on-screen instructions to install the Windows 10 operating system.
Install the Windows drivers from the Device Drivers & Utilities + User’s Manual
disc as per Table 4 - 1, on page 4 - 4 (make sure you install the Intel Rapid
Storage Technology driver - see overleaf).

Run the Intel® Rapid Storage Technology application to manage your Intel®
Optane™ system as instructed in “Intel® Rapid Storage Technology for
Optane Systems” on page 6 - 25.

Creating a Windows
Partition for Optane

When installing Win-
dows, make sure that
you leave a minimum of
5MB of unallocated
space for the Intel® Op-
tane™ software to cre-
ate needed metadata.

After you have created a
Windows partition the
Windows Setup screen
will display the partitions
and sizes, including the
unallocated space. If the
unallocated space is
less than 5MB, then de-
lete the partitions and
recreate them until the
criteria is met.

Note this is 5MB only,
not GB.
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25. After installing the Intel® Rapid Storage Technology application you can access
Device Manager (right-click the Start menu and select Device Manager).
26. Click Disk drives to check the Optane drive.

% Device Manager
File Action View Help

~ M DESKTOP-EFITHGK
i Awudio inputs and outputs
. 43 Batteries
B3 computer

Flgure6 ) 3 - Intel Opt. 466GBSSD
Device Manager == Intel Optane

(Disk drives) M Firmware

#Hl Human Interface Devices

<i= Imaging devices

—1 Keyboards

L I Memory technology devices

g Mice and other pointing devices
» B8 Monitors

P Network adapters
> n Processors

l‘, Security devices

B software devices

i} Sound, video and game controllers
- S Storage controllers
> @ system devices

ﬁ Universal Serial Bus controllers

.|
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Clearing Intel® Optane™

If you wish to clear an existing Intel® Optane™ setup then follow the procedure be-
low to do so. However backup up any necessary files and data before clearing an
Intel® Optane™ setup, as doing so will result in the loss of all data on the volumes.

1. Make sure that Intel® Optane™ is Enabled in the Intel® Rapid Storage Tech-
nology application.

2. Start-up your computer and press <F2> to enter the BIOS.

3. GotoIntel(R) Rapid Storage Technology (in the Advanced menu) and press
<Enter>.

4. Select Intel Optane, **** (listed under Optane Volume:) and press <Enter>.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

Figure6- 4
Intel(R) Rapid
Storage Technology
(Advanced Menu)

p Intel Optane, ***kkiid

.|
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5. Select “Deconcatentate” and press <Enter>.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

p Deconcatentate

Figure6-5
Intel(R) Rapid
Storage Technology
(Deconcatentate)

6. Select Yes from the “Are you sure you want to perform deconcatentation”
option.
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7. Select “Start deconcatentation” and press <Enter>.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

Are you sure you want to perform
deconcatenation?

Figure6-6
Intel(R) Rapid
Storage Technology
(Start
Deconcatentation)

8. The system will return to the standard Intel(R) Rapid Storage Technology menu
when complete (see Figure 6 - 2 on page 6 - 4).

9. You should then select the appropriate SATA Mode for your system and reinstall
the OS.

.|
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y Wireless LAN Module

SN
/Z’l\ If you have included an Intel® WirelessLAN & Bluetooth Combo module is on

nggre;ii iebvo'zfd (i.e. the systemis not in Airplane Mode) before installing the driver.

AllCTaft Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 4.

The use of any portable

Seienleenees e @ Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
CEVEESECEREICRE e S & Bluetooth Combo modules.

is usually prohibited.

VELCNERNERIENNEAY  Intel® WLAN Driver Installation

e yOS“;r‘;“J:i(rfé 1. Makesurethesystemisnot in Airplane M ode, and then insert the Device

the computer aboard Drivers & Utilities + User’s Manual disc into the DVD drive.

aircraft by putting the Click Option Drivers (button).

S I (9 AP Click 1.Install WLAN Driver > Yes.

Mode (see Clicgliln the check box to agree to the End User License Agreement and click
Install.

Click Finish.

The operating system is the default setting for Wireless LAN control in
Windows (see page 6 - 11).

).

o0 ~WD

. |
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WLAN Configuration in Windows 10

Y ou can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)

before configuration begins.

1
2.
3.
4

Click the Wireless icon “ in the notification area of the taskbar.

Modules

Make sure that Airplane mode is off (the Airplane mode icon should be gray).
A list of available access points will appear.
Double-click an access point to connect to it (or click it and click Connect).

RD114
'

Open

D Connect automaticalhe

Figure6-7
WiFi & Network
Connections
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o

Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

7. When you are connected to the network access point it will display Connected
status [@NeEel.

8. Select any connected network and click Disconnect to disconnect

from a connected access point.

o

\ A/
2§
Wireless Device
b Operation Aboard Aircraft

The use of any portable electronic

Disconnect

transmission devices aboard aircraft is

usually prohibited.
Figure6- 8
Network Connected Make sure the module is either OFF or

(Click Disconnect) in Airplane mode if you are using the
computer aboard aircraft.
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9. You can click the Airplane Mode button to turn the mode On or Off.

10. You need to either use Airplane Mode, or turn the WLAN module off aboard
aircraft.

11. Network & Internet in Windows Settings will bring up a more comprehensive list
of network and internet settings including Wi-Fi (can be turned on/off), Airplane
mode (Airplane mode and Wireless devices can be turned on/off) VPN, Dial-up,
Ethernet and Proxy.

o - -
& tions Wi-Fi
Wi-Fi
i @ o
il 8 s it
» 0 @ '- . |
I we . L ¢ known ne + i
. ik ool Setir Ll Wi-Fi services FI gure 6 = 9
A v St oMo Network & Internet

PO— Settings

Network & Internet O on
Wi-Fi, airplane mode, VPN 2

Wireless LAN Module 6 - 13




Fingerprint Reader
and Power Saving
States

If your computer is in a
power saving state (e.g.
Hibernate or Sleep) you
should keep your finger
clear of the fingerprint
sensor.

Allow the system to fully
resume before swiping
your finger across the
sensor.

Fingerprint Reader Module

(Factory Option for ModelsA, C & D Only)

The fingerprint reader module provides a high level of security for your computer.
Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Install the driver from the Device Drivers & Utilities + User’s Manual disc by
following the appropriate instructions on the page overleaf.

The fingerprint reader module uses the Sign-in options configuration of the Win-
dows Account.

Fingerprint Reader Driver Installation

1

SOUkLN

~

Insert the Device Drivers & Utilities + User’'s Manual disc into an attached
CD/DVD drive.

Click Option Drivers.

Click 2.Install Fingerprint Driver > Yes.

Click Next.

Click Finish to complete the installation.

The fingerprint reader module uses the Sign-in options configuration of the
Windows Account (see overleaf).

Make sure you close the DriversiInstaller application before setting up
thefingerprint reader in Sign-in options.

.|
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Fingerprint Module Configuration WA
1. Click the Settings item in the Start Menu and then click Accounts and click Sign- ’Ll‘

in options. PIN Code
2. You will need to add a Windows password (click Add under Password). You will be asked to add
3. After you have added the password you will need to also add a PIN. a PIN code when setting
4. Under Windows Hello click Set up under Fingerprint. up the Fingerprint Read-
5.

The wizard will then guide you through the set up process to scan your fingerprints. er. This is in addition to
your windows pass-
word.

@ Home Require sign-in

| Find a serting | IFyourve been away, when should Windows reduite you to ign in again?

Note this code as it may
..... be required to help you

Whan P wales up from sicep

AR Yourinfo Windows Hells setup ® hrdot Yl setp

sign-in if there are any
0 emai & app accous o L. issues with using the fin-
& Sonncations .I, gerprint reader to sign-in

B Access work of schesl ind (See
B, Family & other peopie { @

B mpses ).
Q
Swipe your finger on the fingerprint sensar Swipe again

N8 Cantinue swiging until Windaws Hella setup is complete.

g

: Figure6 - 10
M.{ G ] Accounts - Sign-in

‘ options

| fargat my PIN

(Add Fingerprint)
B4 Picture password

Sign in to Windows using a favorite photo
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6. You will be instructed to swipe the same finger across the reader a number of
times.

7. Try to present different parts of your finger in different positions (similar to the
various positions you may use when using it, and if you see red at any point try a
different position).

8. Click Close when complete.

9. You can choose to Add another finger (this is recommended) or Remove the
current fingerprint reading.

10. You can now scan your fingerprint to log-on to the computer.

\ A/
L&
Fingerprint Sign-In Issues

If at the Windows Hello screen, the Fingerprint reader fails to recognize the fingerprint
3 times it will then block access to the computer.

In this case you will need to use your PIN (the PIN you used when initially setting up the
fingerprint reader) to access the computer. Alternatively you can sign-in using your win-
dows password.

After using the PIN code (or windows Password) to access the computer you can go to the
Settings > Accounts > Sign-in options if you wish to change any settings.
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Bluetooth & WLAN Combo Module

If you have included an Intel® Wireless LAN & Bluetooth Combo moduleison
(i.e. the system isnot in Airplane M ode) before installing the driver.

Wireless Device
Operation Aboard

Make sure that the module ison (i.e. the systemis not in Airplane M ode) before in- Alrcrat

stalling the driver. The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported

in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.

).

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.

. |
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Intel Bluetooth Combo Driver Installation

1. Makesurethesystemisnot in Airplane Mode, and then insert the Device
Drivers & Utilities + User’s Manual disc into an attached DVD drive.
Click Option Drivers (button).

Click 3.Install Combo BT Driver > Yes.

Click Next > Next.

Click in the check box to accept the license and click Next.

Select the setup type (Typical is recommended) and click Install.

Click Finish.

See “ Bluetooth Configuration in Windows” on page 6 - 19 for configura-
tion instructions.

ONOOUAWDN

. |
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Bluetooth Configuration in Windows

1. Go to the Settings control panel and click Devices (or click the Bluetooth icon
in the taskbar and click Add a Bluetooth Device).

2. Click Bluetooth & other devices and make sure Bluetooth is On.

3. Click Add Bluetooth or other device > Bluetooth (Add a device) and a list of
discovered devices will appear.

B - ‘ Add a Bluetooth Device
S Home Bluetooth & other devices Al s D er i Chnne Figure 6-11
Show Bluetooth Devices Settings > Bluetooth
_ — & Other Devices
& Wt i (Add a Bluetooth
r Mouse, keyboard, & pen Receive a File Device)

0 Join a Personal Area Metwork

Other devices

o Pen & Windaws Ink o M Storage Device Ouffen :ﬂ_ttings.

Remove lcon

Add a device

:35 AM
A i Y2 da 11:35 AM I:.‘

5/8/2017

Add a device

Choose the kind of device you want to add. Fl gure 6 = 12

Add a Device

* Bluetooth
Mice, keyboards, pens, or other kinds of Bluetooth devices
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4. Double-click the device you want to pair with the computer and click Connect, if

the PIN matches that on the device to which you wish to connect (you may
need to click paid on the device).

Add a device
Add a device
Make sure your device is turned on and discoverable. Select a device below to
Figure6 - 13 connect. i device

b Bluetooth Connect D PHonc Add a device

Make sure your device is turned on and discoverable. Select a device below to
connect

E;l U_NB D iPhon

NBENO

Cancel
Add a device
Unknown device

Your device is ready to go!

Unknown device

_ Disconnect
Unknown device
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5. Select a device and click Remove Device Remove device

any device (click Yes to confirm).

@

Home

I Find a setting

2

|

=

Devices

Bluetooth & other devices

Printers & scanners

Mouse

Touchpad

Typing

Pen & Windows Ink

AutoPlay

usBe

Bluetooth & other devices

+ Add Bluetooth or other device

Bluetooth
@ on

Now discoverable as "DESKTOP-H7ABCBU"

Mouse, keyboard, & pen
o USB Optical Mouse

Other devices

Mass Storage Device

[z}

iPhane
Connected

Remove device

] Download over metered connections

Tn heln nrevent syira charnes kessn thic nff sn devies snftwars

to disconnect from

Modules

Figure6- 14
Bluetooth Remove
Device
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To Make your Computer Discoverable to Bluetooth Devices

1. Go to the Settings control panel and click Devices (or click the Bluetooth icon

in the taskbar and click Open Settings).

Click Bluetooth & other devices and click More Bluetooth options.

3. InBluetooth Settings make sure that Allow Bluetooth devices to find this PC
check box (Discovery) has a check inside it.

4. Make sure that the Alert me when a new Bluetooth device wants to connect
check box (Notifications) has a check inside it, if you want to be notified when a
Bluetooth device wants to connect.

ettings = L b

n

| O Bluetooth Sertings *
& Home Bluetooth & other devices
] I_I Lownload cver metered Connections
d a setting F =

|

| Options COM Ports  Hardwars
-J Discovery

ad [FliAllow Bluetooth devices 1o find this PC

L Bluetooth devices will see the name of this PC.

L | etooth & other devices .
i Bluetooth & other devices Related settings

5 and printers ‘ Natifications

& Printers & scanners Devie
F - 6 15 [] Alert me when a new Bluetooth device wanis to connect
I Ure = Sound settings
g 0 Mause e
B I u e'[OOth Set“ n g S o Teudivad Display settings [ Show the Bluetoath icon in the potification area
[ouchp:
B Typing

LY

= Pen & Windows Ink

() AutoPlay

B Have a question?
1 USB |
Get hedp

Bestore Defaults

Make Windows better. | [ ]| conen Boply
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Intel® Software Guard Extensions Driver

Install the Intel® Software Guard Extensions Driver which provides a set of in-
structions allowing user-level code a degree of security, and privacy, from the oper-
ating system. Make sure that SW Guard Extensions is Enabled in the BIOS
beforeinstalling thedriver (see” Software Guard Extensions (Advanced Menu >

Advanced Chipset Control)” on page5 - 9).

Intel SGX Driver Installation

1. Insert the Device Drivers & Utilities+ User’s Manual disc into an attached
DVD drive.
Click Option Drivers (button).

2.
3. Click 4.Install Intel SGX Driver > Yes.
4. Click OK > OK to complete the installation.

. |
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IRST and M.2 PCl-e
SSDs

Note that Intel® Rapid
Storage Technology
does not support M.2
SSDs with a PCl-e In-
terface (M.2 SSDs with
a SATA Interface are
supported).

Intel® Rapid Storage Technology

The Intel® Rapid Storage Technology driver supports your AHCI mode SATA
drive, or your I ntel® Optane™ system. Install the Intel Rapid Storage Technolo-
gy application (after installing all necessary driversin the correct order) to support
your Optane system or SATA driveif set upin AHCI modeinthe BIOS (see“ SA-
TA Mode (Advanced Menu)” on page 5 - 10).

IRST Driver Installation

1

N AWDN

Insert the Device Drivers & Utilities+ User’s Manual disc into an attached
DVD drive.

Click Option Drivers (button).

Click 5.Install IRST Driver > Yes.

Click Next.

Click in the check box to accept the license and click Next.

Click Next > Next > Next.

Click Finish to restart the computer.

Run the Intel® Rapid Storage Technology app from the Apps screen.

After setting the SATA modeto Intel® Optane™ and installing the I ntel® Rapid
Storage Technology application, DO NOT uninstall the Intel® Rapid Storage
Technology application.
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Intel® Rapid Storage Technology for Optane Systems

Intel® Rapid Storage Technology application displays status information on your
Intel® Optane™ configuration. Run the Intel® Rapid Stor age Technology appli-
cation from the item in the Start menu.

When the Intel® Rapid Storage Technology application is launched the system

will open the Status window. Here you can view the general health of the storage
system. Various volume creation and management options are available depending

on the system’ s status.
4 Intel® Rapid Storage Technology - D x a
‘m Manage ! Intel® Dptane™ Memory | Performance | Preferences Help intel)
M Ristuimiaaiica | | |

| ==t

._Tf Current Status Storage System View @]I

o Figure 6 - 16
ey 7 Qg 75001 Intel® Rapid
Storage Technology
Status

Intel® Optane™ Memory

Intel® Optane™ memory status: disabled. Enable

.|
Intel® Rapid Storage Technology 6 - 25



Modules

Enabling Intel® Optane™

1. Runthe Intel® Rapid Storage Technology application.
2. Click Enable.

¥ Intel® Rapid Storage Technology - o *

Flgure 6 = 17 “ Marnage , atel® Optane™ Memery | Performance
IRST - Intel® : ' _
Optane™ Memory  Current Status Storae Sptem View )

(En ab | 6) Your systemn s functioning normaily. (Vs ; u‘— Isl 1466 G} [System
Manage

Preferences

PClie 550 (13 GB)
- &
G 13c8

Click e any elernent in the s1crage system view 1 Manage its properties.
00 The Windows* write-cache butfier flushing policy can be enabied for al RAID arvay deives to ensure data integeity or disabled to
improwve data performance. Click the Melp ican for more information on setting the write-cache buffer fluthing palicy bated on

your needs. =

T “ Enable
Intel ® Optane™ memory status: o @

3. The system will pop-up a message and ask you to select a compatible fast drive
(in this case there should only be one option).

Enable Intel ® Optane™ memary -

Select a compatible fast drive:

FIgUI’e 6 = 18 lpcu- 550 on Controller 3, Port 0 {13 GB) -
| RST - Intel ® ""‘;:':::'::c” Contrelier 0, Port 0 (466 GA) (system)
Enable Optane™

Memo I‘y O After Intel ® Optane™ memory is enabled, please restant your PC before perfarming any partition o formatting
Operaions.

0 Ensure that the PC is connected o an AC power source during this process.

1, This process will take some time and may ively impact system p All data on the fast
drive will be erased. Do you want to enable Intel ® Optane™ memory now?

Maore help s m
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You will need to restart the computer after enabling Optane, and make sure the
system is powered by the powered AC/DC adapter, and not by battery only.

Click Yes to begin the process (this may take some time).

After the process has been completed restart the computer.

After restarting can access Device Manager (right-click the Start menu and select
Device Manager).

Click Disk drives to check that the drive should read Intel Optane ******,

;.‘..; Device Manager

File Action View Help Figure6 - 19
= = | B Device Manager
o= L (Disk drives)

v % DESKTOP-EFITHGK

i} Audio inputs and outputs
@ Batteries
[a Computer

% Disk drives

(= Intel Optane+466GBSSD )

L@l Display adapters
i Firmware
i Human Interface Devices

_‘?;' Imaging devices
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9. Run the Intel® Rapid Storage Technology application to check the status.

43" Intel® Rapid Storage Technology

Intel ® Optane™ Mamory Parformance I Breferences Help | intel

+/ Current Status mm— »
Your systern is functioning normally, S NN
- e
Click on any element in the storage system view to manage its properties. @ w 466 GB m‘m"ww
i - 0 The Windows* write-cache buffer flushing policy can be enabled for all RAID array drives to ensure data 1368 466 GB
FI gur e 6 20 integrity or disabled to improve data performance. Click the Help icon for more information on setting the w L
IRST - |ntel® wit-cache buffec fushing policy based on your needs. &
Optane™ Memory Intel® Optane™ Memory
(En abl ed) Inte! ® Optane™ memory status: enabled. Disabie

Intel® Optane™ Memory

Intel® Optane™ memory status: enabled. Disable

.|
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Disabling Intel® Optane™
If you need to disable Intel® Optane™ for any reason follow these instructions.

Disabling Intel®

1. Runthe Intel® Rapid Storage Technology application.

: - Optane™
2. Click Disable.
@ Intel® Rapid Storage Technology = o x Disable . Intel® Op-
tane™ if you want to
Intel® Optane™ Memory | Parformance | Preferences Help intel reinstall/reset the SyS-
tem or update the
/ Current Status Storage System View © IRST driver. See also
Your system is functioning nonmally. Intel® Optane™ Mamary Array
- e
Click on any element in the storage system view 1o manage its properties. ® @; 466 GB. m‘h‘:l:mc" M?;m‘?:;m
O The Windows* write-cache buffer flushing policy can be enabled for all RAID array drives to ensure data el 138 ik
integrity or disabled to impeove data performance. Click the Help icon for more information on setting the .
write-cache buffer flushing poficy based on your needs 3‘ FI gur e 6 = 21
intel® Optane™| |yt ne™ Memory IRST - Intel®
Intel® Optane™ i P = " Optane“" Memory
nte! tane™ memory stattss (= 1Sable .
P v e N (Disable)

3. Click Yes when the message pops up.

Intel® Rapid Storage Technology ‘

Disabling Intel® Optane™ memory will take some time and negatively impact system performance. No data will be
lost during this process. Do you want to disable Intel® Optane™ memory now?

Figure6 - 22
IRST - Yes to

More help Yes No Disable
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HDDs & Intel®
Optane™ SSDs

Note that if your sys-
tem’s HDD or Intel®
Optane™ SSD is to be
transferred to another
system for use for any
reason, you will need
to disable Intel® Op-
tane™ in IRST first.

Removal of any cov-
er(s) and /or screw(s)
violates the terms of
your warranty.

Figure6 - 23
IRST - Intel®
Optane™ Memory
(Status)

No ok

Restart the computer to complete the process.

Run the Intel® Rapid Storage Technology application.

The Status of Intel® Optane™ Memory is indicated in the Window.

To enable Intel® Optane™ Memory follow the process indicated in “Enabling
Intel® Optane™” on page 6 - 26.

& Intel® Rapid Storage Technology - o b

Intel® Optane™ Memary J Performance Preferences | Help ‘

Storage System View @

@ , SATA disk (466 GB) (System)
456 GB

w PCle 550 (13 GB)
13GE

-@ Current Status
Your system is functioning normally.

Manage
(42
Click on any element in the storage system view to manage its properties. =

{0 The Windows* write-cache buffer flushing policy can be enabled for all RAID array drives to ensure data integrity or disabled to
improve data performance. Click the Help icon for more information on setting the write-cache buffer flushing policy based on
your 5. "o

Intel® Optane™ Memory
Intel® Optane™ memory status: disabled. Enable

Intel® Optane™ Memory

Intel ® Optane™ memory status: disabled. Enable
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Sound Blaster Cinema 5

Install the Sound Blaster Connect application isasuite of audio technologieswhich
allow you to configure the audio settings to your requirements for the best perfor-
mance in games, music and movies.

Sound Blaster Cinema 5 Installation

1. Beforeinstalling the driver make sure you have aworking internet connec-
tion.

2. Insert the Device Drivers & Utilities+ User’s Manual disc into an attached

DVD drive.

Click Option Drivers (button).

Click 6.Install Creative Driver > Yes.

Select the installation language and click OK.

Click OK and the system will automatically restart to complete the driver

installation process.

The Sound Blaster Connect App will download but you will need to have

aworking internet connection.

8. Click the Sart menu in Windows to access the Microsoft Store App tile
under Explore.

9. ClicktheSigninicon &, and select Downloads and updates.

10. Click Check for Updates.

11. A list of apps being downloaded will pop-up.

oA ®

~N

. |
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12. To prioritize the Sound Blaster Connect driver you can click Pause all to
pause the download queue.

13. Click on Sound Blaster Connect and click on the resumeicon O to down-
load the driver.

14. When just installed the Sound Blaster Connect will appear in the Win-
dows Start menu.
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Sound Blaster Connect Application
Run the Sound Blaster Connect control panel from the Start menu in Windows.

Play
More ways
Paid Wi-Fi & Cellular We speak Yahoo to play. Join
.
' Paint 3D
Calendar ~] s -
People . § ’ Figure6 - 24
Photos " Sy =l ¢ § Sound Blaster
o —_— J Connect
Mo  Get Office OneNote [ Solitai n (W| ndows Start
. | Realtek Audio Console 2 -
New Menu)

Explore

Microsoft Store Microsoft Edge

Settings

§ Sound Blaster Connect i 8 -
e ;! R l

CES
,* ‘ly t L fa) XBOX LIVE
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4

Settings

Click on Settings if you
need to change the in-
terface language or to
reset all back to the de-
faults.

Figure6 - 25
Sound Blaster
Connect - Sound
Experience

Sound Blaster Connect (Sound Experience)

You can save configured sound settings under the EQ and SBX Pro Studio in
Sound Experience. You can create your own Library settings by clicking the plus
iconin Library [ISSSEEEE. Click the Output icon to select Headphones or
Speakers.

Output
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Sound Blaster Connect (Headphones)
Configure Headphone types by selecting the most appropriate type.

Figure6 - 26
Sound Blaster
Connect -
Headphones
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Sound Blaster Connect (Speakers)
Configure and test the settings for Speaker s from this menu.

Figure6 - 27
Sound Blaster
Connect - Speakers
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Intel® Speed Shift Technology Driver
Install the Intel® Speed Shift Technology driver as outlined below. Speed Shift

Modules

4

*P-States

Technology allows operating system to hand off some or all control of the handing
of the computer’ s* P-Statesto the processor. Thishas acouple of noticeable benefits | P-states are voltage-fre-

in responsiveness and the reduction of power consumption.

guency pairs that set the
speed and power con-

Speed Shift Technology Driver Installation ig?gon of the copro-
1. Insert the Device Drivers & Utilities+ User’'s Manual disc into an attached . ' .
. en the operating volt-

DVD drive. age of the processor is
2. Click Option Drivers (button). lower, so is the power
3. Click 7.Install Speed Shift Driver > Yes. consumption.
4. When the“Isthis package from a source you trust?’ message pops-up click

“Yes, add it”.
5. Thiswill complete the installation procedure.
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PC Camera

Use the Fn + F10 key combination (see “ Function Keys & Visual Indicators’ on
page 1 - 19) or Control Center button to toggle power to the PC Camera module.

When the PC Camera s in use the LED indicator to the left of the camera will be
illuminated (sce @ Figure 1 - 2 on page 1 - 6).

Note that you need to use the Camer a app in Windowsto take pictures and cap-
ture video.

. |
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Camera App

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or
Control Center button).

2. Runthe Camera app from the Start menu by clicking on the Camera app icon
(you can type “camera” into the search box to find the Camera app).

3. The interface displays two buttons on the right of the screen; one for photo and
one for video.

=
=N Figure 6 - 28
h __.-l"li Camera App Mode
Photo Video lcons
4. Simply click on the appropriate button to switch to either photo or video modes.
5. You can use the buttons at the top of the screen to access the Settings and Auto/
Pro menus (for HDR, Photo Timer or Brightness).
Auto Pro
Figure6 - 29
Camera Menu
Buttons
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Figure6 - 30
Camera Settings

6 - 40 PC Camera

6. Click Settings

to access the camera settings menu to make adjustments for

Camera press and hold button, photo Quality, Framing grid, Time lapse,
Video Quality, Flicker reduction and Digital video stabilization.

< SETTINGS

When | press and hold the camera button

Take one photo

Photos
Quality

0.9MP 16:9 (1280x720)

Framing grid

Time lapse
When the timer is on, keep taking photos until | press
the camera button again

@ on

Videos
Quality

T20p 16:9 30fps

Flicker reduction

50 Hz

Digital video stabilization

@D on

Related settings

Change where photos and videos are saved

Choose whether camera can use location info

4

Camera Settings

The Self Timer can be set to take Photos after 2, 5 or 10
seconds.

The Quality can be changed to that which the system sup-
ports.

You can use a Framing grid to help you line up pictures.

Time lapse can be set to keep taking photos until the cam-
era button is pressed again.

The video Quality resolution and frame rate can be set to
any supported by the system. Note that capturing high res-
olution video files requires a substantial amount of disk
space for each file. After recording video, check the video
file size (right-click the file and select Properties) and the re-
maining free space on your hard disk (go to File Explorer,
right-click the hard disk, and select Properties). If necessary
you can remove the recorded video file to a removable me-
dium e.g. a USB Flash drive.

If you need to reduce any screen flicker, change the settings
in Flicker reduction to either e.g. 50Hz or 60Hz.
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7. With the Pro menu expanded you can access the Brightness button to adjust the
brightness.

Figure6 - 31 a
Camera Brightness

Adjustment

PC Camera 6 - 41



Modules

Taking Pictures/Capturing Video

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or
Control Center button).

2.  Runthe Camera app from the Start menu by clicking on the Camera app icon
(you can type “camera” into the search box to find the Camera app).

3. Click to select either photo (@ or video | =) modes.
4. Click the photo icon to take a picture. -
5. Click on the video icon to start video capture (when video capture begins a
timer will appear at the bottom of the screen). N
b 6. To stop video capture click the stop o button (you can also pause the video
capture).

Figure6 - 32
Video Camera
Recording in
Process
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7. Captured photos and videos will be saved to the Photos app stored in the Start
menu (type Photos into the search box if you cannot find the app). You can also
access the photos from the Camera roll icon at the bottom right of the Camera

app screen.
Play
See all your mail in one place More ways
to play. Join
o -
B Xbox >
—
u -~ MINELRREFY
OneNote @
€ Realtek Audio Console e — Flgure 6 - 33
Photos App
(For Captured
Photos & Videos)
&
Camera Roll in the
Camera App

Camera roll

o) ’Type here to search

PC Camera 6 - 43



Modules

Trusted Platform Module

(Optional)

The TPM security chip allowsyou to create and manage digital certificatesfor user
and platform authentication. This type of security is usually administered within
large enterprises and organizations, and therefore requires implementation by a sys-
tem administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection. In addition M ake sure you prepare
aremovablemedia (e.g. aUSB flash drive) to store passwor dsetc. befor e begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.
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Enabling & Managing TPM

Restart the computer.

Enter the Aptio Setup Utility pressing F2 during the POST/startup.
Use the arrow keys to select the Security menu.

Select TPM Configuration and press Enter to access the sub-menu.

Press F4 to save the changes and restart the computer.
You can now manage the TPM from Windows.

Nog,rwdhE

Aptio Setup Utility — Copyright (C) 2016 American Megatrends Inc.

Security Device Support

Press Enter to access the Security Device Support menu and select Enable.

Modules

4

Clearing TPM
Information

You can select Pend-

ing operation, and
then select TPM clear
to clear existing TPM
information in order to
reset the TPM.

Figure6 - 34
TPM State (Enable)

. |
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TPM Management in Windows
Y ou can manage your TPM settings from within Windows:
1. Go to the Control Panel.

2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.

A BitLocker Drive Encryption m]
£~ T & « All Control Panel ltems » BitLocker Drive Encryption (4]
SonuotRng ame BitLocker Drive Encryption
. Help protect your files and folders from unauthorized access by protecting your drives with
F|gure 6 - 35 Bitlocicer.
BitLocker Drive
Encryption Operating system drive
(TPM C: BitLocker off
Administration)
= 9 Turn on Bitlocker

~
Fixed data drives

Remowvable data drives - BitLocker To Go

w MEMSTICK (D) BitLocker off
WY Disk Management

Privacy statement !;J TPM Administration
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4. The TPM Management window allows you to configure the TPM within Windows.
As TPM is usually administered within large enterprises and organizations, your
system administrator will need to assist you in managing the information here.

M Trusted Platform Module (TPM) Management on Local Computer = o *

@ Eile  Action  View Window Help -

4= | M Hm

o T Mgt on o o =

TPM Management on Local Computer -
& TPM Managsmant on Local Computer 2
Canfigures the TPM and its suppont by the Windows platforn B3 Prepare the TP,
B} Change Owner Password...
Overview * | Clear TPM...
Windows computen contanng the Trusted Platfoen Module (TPM) securty hardware provide snhanced B Reset TPM Lockout...
securty fentures for spplications, This snap+n displays information about the computer's TPM and alows
adminstraton 1o corfigure the device. | aiso slows administrators 10 view and manage commands WView » .
underiood by tha davice MNew Window from Here F| gUI’ e 6 = 36
| & Refresh
Satue § Trusted Platform
Help
The TPM i ready Tor use, with reduced functionalt)
e il Module (TPM)
TPM Maagemert £ Management on
@ O TPHowsrposmwcnd, 1 Local Computer
Olear the TPM to remove ownership and resst the TPM o factony defauls . .
L i Administration
WARNING: Clmaring the TPM causss you to lose sl TPM keys and data protected by those keys
TPM Manudacturer information
Marufacturer Name: IFX Marufacturer Vermion: 5.0 Specfication Verson: 2.0
< > le >
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TPM Actions

1. Click Prepare the TPM and follow the instructions in the Wizard to prepare the
TPM (this will probably require a restart of the computer and confirmation of the
setting changes after restart by pressing the appropriate F key).

2. After the restart the TPM will be prepared and you can then use the Actions menu
to Turn TPM off, Change Owner Password, Clear TPM or Reset TPM Lockout.

3. A wizard will help take you through any setup steps.

Actions
b TPM Management on Local Computer A

Figure6 - 37
TPM Actions Menu Prepare the TPM...

Change Owner Password...

Clear TPM...

Reset TPM Lockout...

View »

New Window from Here

Refresh

BB

Heln
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BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk. Access the Microsoft BitL ocker Drive Encryption control panel
applet from the Windows control panel (System and Security).

1. Click Turn on Bit Locker.
2. Follow the on-screen instructions to setup BitLocker, and make sure you have a
removable media (e.g. a USB flash drive) to store saved recovery keys etc.

A BitLocker Drive Encryption m] 4
A 1 “& « All Control Panel ltems > BitLocker Drive Encryption v O 5 1 v -l

Control Panel Home

BitLocker Drive Encryption

He rotect 1 file: d folders fron nauthorized ess tectin i drive: ith M
is"lt:i:tt you 'S and 1okders rom unauthornzed access by protecting your drnves wi Flgure 6 - 38
BitLocker Drive
Operating system drive Encryption
C: BitLocker off
€ & Tum on Bitocker ~
=
b

Fixed data drives )
1 ® Turn on BitLocker

Removable data drives - BitLocker To Go
MEMSTICK ([x) BitLocker oft
% TPM Administration
W Disk Management

Privacy statement
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4G Module

Wireless Device (For ModelsA & B Only)
OperatibnAboard If you have included an optional 4G/LTE (Long Term Evolution) module (see
Aircraft “Communication” on page D - 3 for specification details) in your purchase option,
ok you do not require a driver/application installation for Windows 10. Follow thein-
electronic traxsrinission struqtions overleaf to install the USIM card (yvhi ch \{vill be provided by your service
devices aboard aircraft provider), and then use the Charms Bar Wirelessicon to access the 4G network

is usually prohibited. in the same manner asthe WLAN.
Make sure the WLAN,
Bluetooth and 4G
module(s) are OFF (or
the system is in Air-
plane Mode) if you are
using the computer
aboard aircraft (see

2MN\L
I

Important Notice

If your purchase option includes both Wireless LAN and 4G modules, then the appropriate
antennas will be installed. Note that In order to comply with FCC RF exposure compliance
requirements, the antenna must not be co-located or operate in conjunction with any other
antenna or transmitter.

Important Notice - 4G & Bluetooth/Wireless LAN Modules

)

In order to comply with FCC regulations you should NOT operate the 4G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 4G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.

. |
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4G Module USIM Card Installation (for Models A & B)
Follow the instructions below to install the USIM card (which will be supplied by

your service provider) which requires the removal of the battery first. Power Safety
Warning

1. Turn the computer off, and turn it over.
2. Slide the latch @ in the direction of the arrow, and then slide latch @ in the Beiohet.you “”de”akg =i
direction of the arrow and hold it in place. ';Zlfeasfrl thafrggﬁ ﬂ:,sé
3.  While holding the latch 9 in place, pull the battery up at point e in the direction turned off the power, and
of the arrow @ to remove the battery @. disconnected all peripher-
4. Insert the USIM card @ (see overleaf). als and cables (including

5. Reinsert the battery (see page 6 - 53). AT

Figure6 - 39
Battery Removal &
USIM Card Insertion
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4G Module USIM Card Installation

Insert the USIM card @ asillustrated below (pay careful attention to the orientation
USIM Card of the card asthe gold contact side of the card should face downwards) until it clicks
Orientation fully into position. To gject the card simply pressit until it gects, but do not attempt
to gect the card while connected to a 4G network (see below).

Note that the USIM
card’s readable side
(with the gold-colored
contacts) should face
downwards as illustrat-
ed.

Figure 6 - 40
USIM Card Insertion

2NZ
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USIM Card Ejection

Simply press on the USIM card to eject it, however do not do this while a connection is in
progress. If you do eject the card while a 4G connection is ongoing, you will need to shut

down the system, reinsert the USIM card, restart the system and then reestablish the 4G con-
nection.

If you wish to change USIM cards then you will need to shut the system down, reinsert the
USIM card, restart the system and then reestablish the 4G connection.
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Battery Insertion

1. Orientate the battery @ as illustrated below and align it with the edges of the bat-
tery compartment.

2. Push the battery in the direction of the arrow @ to insert it into the compartment (it
should click into place).

3. Slide the latch @) in the direction of the arrow into the lock position.

Figure6 - 41 a
Battery Insertion

. |
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4G Configuration in Windows 10
Y ou can configure a 4G connection as below, however make sure the system is not
Connecting to the in Airplane Mode before configuration begins. Y ou can connect to a 3G/4G connec-

Ce”;\*ﬂ'ar Nelfwo”‘ tion in much the same way as the WLAN connection.
anually

1. Click the Settings item in the Start Menu and then click Network and Internet.
CEIEIEGEREUESE 2 Click Cellular and a list of available access points will appear (if you have issues
QPN (Access  Point connecting to the cellular network see the sidebar).
ci) [ S8 EUliBE Click the access point and click Connect.
cally, however if your Th tem will t twork
cellular data connection € syste . connect to your nEwork. .
Connected will appear under the connection.

isn't working, you should . . .
try manually entering a You can then access the internet, download e-mail etc. as per any internet

new Internet APN based connection.

2

on your location and 7. To disconnect you can select the connection and click Disconnect.
mobile operator. See 8. You need to use Airplane Mode aboard aircraft.
page for details. 9. You can also click the Wireless icon - in the notification area of the taskbar, click

Cellular and double-click an access point connect to access the connection
information.
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Troubleshooting

Chapter 7: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sureit isactually working. Check the LED Power Indicators (see“LED Indicators’ on page 1 - 10)
to see the computer’s power status.

Connections - Check all the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Configuring the Power Buttons’ on page 3 - 9), the Fn + F12 key com-
bination, or power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 5, on page 1 - 19).

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB stor age devicesin any connected drive.

.|
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Troubleshooting

Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Boot password for the SCU (see “ Security Menu” on page 5 - 12).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief
notes).

\ A/
2§
Bottom Cover Removal Warning

Users should not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may violate the terms of

your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your dis-
tributor/supplier for further information.
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Troubleshooting

Viruses

» Ingtal an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

» Becareful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

» Keepa“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Troubleshooting

Upgrading and Adding New Hardware/Software

* Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don't open your computer or undertake any repair or upgrade work if as this may violate the terms of your
warranty.

* Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitted “READ ME” or “READ ME FIRST”.

* Wheninstalling a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

* Make sureyou haveinstalled the driversfor any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).

» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

.|
Upgrading and Adding New Hardware/Software 7 - 5



Troubleshooting

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.

.|
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Troubleshooting

Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn't | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator m is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 5) check its settings. You may also be using a
peripheral device/lUSB device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 16).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

. |
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Troubleshooting

Problem

Possible Cause - Solution

The computer feels too hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 20). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

The system will not wake up from a
power saving state (Sleep/Hibernate)
on network activity (Wake on LAN) even
though | have plugged in the powered
AC/DC adapter.

Wake on LAN is supported in AC mode only.

When the system enters a power saving state the plugged in AC/DC adapter
should be connected, and should remain connected, in order to allow the
system to wake up on network activity. Unplugging the adapter, and then
plugging it back in again, will not allow the system to wake up on network
activity.

No image appears on the external
monitor | have plugged in and powered
on.

You haven't installed the video driver and configured it appropriately from the
Control Panel. See Appendix C for instructions on installing and configuring
the video driver.
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Troubleshooting

Problem Possible Cause - Solution

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F12 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

2NZ
Z &

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
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Problem

Possible Cause - Solution

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Keyboard Backlight LED Device” on pagel - 16) to
adjust.

Unwelcome numbers appear when typing.

Num Lock is turned ON (see “LCD Panel Open - Model B” on page 1 - 7).

work.

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system wiill
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,

press the sleep (Fn + F12) key combination, or press the power button if no
LEDs are lit.

The fingerprint reader has problems
scanning fingers.

When fingers are wet or sweaty the software application may have difficulty
reading a scanned finger. Make sure your fingers are clean and dry when
attempting to scan them across the sensor for detection.
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Problem

Possible Cause - Solution

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Check the LED
indicator »= to see if itis in Airplane Mode (see “LED Indicators” on page 1 -
10). Use the Fn + F11 key combination to toggle Airplane Mode on/off (see
Table 1-5,0n page 1-19).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function Keys & Visual Indicators” on page 1 - 19). Run the
camera application to view the camera picture.

The Wireless LAN/Bluetooth modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Wireless LAN Module” on page6 - 10 and/or
“Bluetooth & WLAN Combo Module” on page 6 - 17).

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed
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Problem

Possible Cause - Solution

My internal microphone seems to be
disabled and/or | can still hear sound
from the speakers even though | have
plugged headphones into the headphone
jack.

You have not enabled “Separate all input jacks as independent input devices” in
Device advanced settings.

No sound can be heard through an HDMI
connected display.

You have not configured the HDMI audio output. See “HDMI Audio
Configuration” on page C - 9.

When using a Bluetooth headset the
audio appears to be mono and not
stereo.

This is a common issue with Bluetooth headsets. To resolve this issue do the
following (you will need to repeat this procedure after every boot up, restart,
or when the system resumes from hibernation):

Go to the Devices & Printers control panel in Windows.
Double-click the Bluetooth headset.
Click Connect to complete the stereo connection.

Go to the Sound control panel in Windows.

Right-click (in the Playback tab) the Bluetooth Stereo Audio device (the
default device is Headset).

Click Connect to complete the stereo connection.

NEOwWNPE
Ry
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Problem Possible Cause - Solution

A file being copied to/from a connected | You may have the Bluetooth control panel (Settings > Devices > Bluetooth)
Bluetooth device appears to be | open. When transferring data between the computer and a Bluetooth enabled

transferring very slowly. device, make sure that the Bluetooth control panel is closed.
U T =T
PAS
Bluetooth Control Panel i e S
(Settings > Devices) : - o«
Close the Bluetooth control R
panel (pictured on the right) , By o
when transferring data be- ] nouese
tween the computer and a ..
Bluetooth enabled device. P
Readly 10 paie
=]

. |
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Problem

Possible Cause - Solution

| can't hear any sound from the
microphone in my connected headset,
when trying to test the audio playback.

You need to enable listening to the microphone in the audio control panel in
order to hear any sound through your connected headset as follows:

1.

n

Pow

o

Right-click the volume control icon [iJ} in the taskbar.
Select Recording Devices.

Open Vohime Mixer
Playback devices
Recording devices
Sounds

Troubleshoot sound problenms

Double-click Microphone and select Listen.
Click to put a check in Listen to this device check box.

4 Microphone Properties

General Listen |evels Enhancements Advanced

You can listen to a portable music player or other device through
Microphone jack. If you connect a microphone, you may hear fes

[7] Listen to this device
Click Apply.
You can then listen to the playback though the headset for testing.

Remember to disable this feature (remove the check from the Listen to
this device check box) otherwise you may hear an echo from the internal
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Resolving the “Can’t connect to this network” issue with the 4G Module
(For ModelsA & B Only)

1.

2.

3.

If you have issues connecting to the cellular network when you are attempting to use the 4G network then you
may need to manually connect to the Internet access point name (APN).

Usually the Internet APN is set automatically, however if your cellular data connection isn't working, you should
try manually entering a new Internet APN based on your location and mobile operator.

To find your APN settings contact your mobile operator directly (or of you can connect to a WiFi network on your
PC, or have a phone handy, try searching online to find the Internet APN settings for your mobile operator).
See http://windows.microsoft.com/en-us/windows-10/cellular-settings or search the Microsoft website for
"Windows 10 cellular settings".
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Intel® Optane™ Notes

Intel® Optane™ is a combination of a compatible memory device and Intel Rapid Technology software. This
combination is designed to speed up your system performance. However note the following;

The SATA Mode should be set BEFORE installing an oper ating system, and after you have backed up all
necessary files and data (see sidebar). See“ Setting Up SATA Mode (Optane™ or AHCI)” on page 6 - 2 for
details. Make sure you install the I ntel Rapid Storage Technology application if you have set the SATA
Modeto Intel RST Premium, or to AHCI (see”|RST Driver Installation” on page 6 - 24).

It is very important to make sure that when you create a hard disk drive partition when installing Windows
for an Intel® Optane™ system, that you leave at least aminimum of 5SMB of unallocated space (notethisis
5MB only, not GB).

After setting the SATA modeto Intel® Optane™ and installing the Intel® Rapid Storage Technology
application, DO NOT uninstall the Intel® Rapid Sorage Technology application.

If you are reinstalling a system that has previously been setup in Intel RST Premium mode, make sure
you have cleared the Intel Optane Memory (see“ Clearing I ntel® Optane™” on page 6 - 7). If you
haven't cleared the Optane setup you may not find a suitable hard disk drive partition on which to reinstall
an operating system.

If you need to reinstall an operating system, uninstall the IRST driver/application or swap the hard disk
drive (or Intel® Optane™ SSD) make sure you have cleared the Intel Optane Memory (see“ Clearing
Intel® Optane™” on page 6 - 7).
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Interface (Ports & Jacks)

Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
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Interface (Ports & Jacks)

Ports and Jacks

Item

Description

Card Reader

O SD/MMC

The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC (up to UHS-II)

Push the card into the slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) port is an audio/video connector
interface for transmitting uncompressed digital streams. This allows you to connect an external
monitor, TV or Flat Panel Display etc. as a display device (see “Attaching Other Displays” on
page C - 29) by means of a HDMI cable. Note that HDMI carries both audio and video
signals.

Headphone-Out Jack

@

Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Microphone-In Jack

fg\

Plug an external microphone in to this jack to record on your computer.

A - 2 Interface (Ports & Jacks)




Interface (Ports & Jacks)

Item

Description

Mini DisplayPort 1.2

]

Mini DisplayPort 1.3

°|Cl

The Mini DisplayPorts are a miniatuarized version of the DisplayPort, which is a digital display
interface standard that allows a digital audio/video interconnect, between the computer and its
external display or a home-theater system.

2N
2§

Mini DisplayPort Cables

When using cables connected to the Mini DisplayPort, try to make sure that the cables are not bent
excessively, as bending the cables may cause signal problems.

RJ-45 LAN Jack

B8

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot

33

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.
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Item

Description

USB 2.0/1.1 Port

.

USB 3.0 (USB3.1Gen1
Type A) Port

USB 3.1 (USB 3.1 Gen 2
Type A & Type C) Port

5=

USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals
such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs,
digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and
unplugged from the computer, without the need to turn the system off (if the power rating of your
USB device is 500mA or above, make sure you use the power supply which comes with the
device).

USB 3.0 ports capable of 5Gbps (SuperSpeed) are classified as USB 3.1 Gen 1 and USB 3.1
Gen 2 ports are capable of 10Gbps SuperSpeed+.

This model series has one USB 2.0 port, one USB 3.0 port (USB 3.1 Gen 1 - Type A), one
USB 3.1 Gen 2 port (Type A) and one USB 3.1 Gen 2 port (Type C). The Type C port is the
smaller sized USB port.

Note: The maximum amount of current supplied by USB Type-C ports is 500 mA for USB2.0/900
mA for USB 3.1
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Appendix B: Control Center

Overview

The following chapter will give aquick description of the functions of the Control Center & Flexikey® appli-
cations.

Control Center
The Control Center gives quick access to frequently used controls and settings. Click the Control Center icons
to toggle the appropriate function, or hold the mouse button down and move the dial control where applicable.

Flexikey®

The Flexikey® application isaquick hotkey configuration application, which allowsyou to assign asinglekey
to launch multiple key combinations, or to launch programsand applications, to create text macr os and to
disable certain keys. The application can also be used to configure the mouse buttons to create hotkeys for
gaming etc. All the configuration settings are retained under (up to12) profiles to which the settings are applied.
Click Flexikey in the Control Center to launch the application.
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Control Center Access

To run the Control Center press the Fn + Esc key combination, or double-click the icon n
in the notification area of the taskbar.

Close the Control Center by clicking the close icon in the top right of the panel.

Flexikey® Access

The Flexikey® is accessed from within the Control Center by clicking FlexiKey® in the top
left of the Control Center.

Figure B - 1 - Control Center & FlexiKey
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Control Center Menus
The Control Center contains 5 menu headings (System Monitor, L ED Device, Basic Setting, FlexiK ey and
Extra Setting) in the top left of the Control Center. Click the menu headings and then click any of the but-
tons outlined on the following pages.
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Figure B - 2 - Control Center Menus
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System Monitor

Y ou can set thefan speed to M aximum (full power), Automatic or Custom from this menu item. The fan speed
will adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum
if you prefer. You can use the Offset slider to adjust the settings to your preference, however these settings can
be overridden by the system as a safety precaution, if it requires heavier use of the fan.

The Custom setting alows you to click and drag on any of the 2 midrange nodes on the graph in order to adjust
the temperature parameters of the CPU Fan or GPU Fan (click on the CPU Fan or GPU Fanicon for either on
to select it, then click and drag either of the midrange nodes).

¢ CONTROL CENTER 2O

Figure B - 3 - CPU/GPU Fan Custom Settings

.|
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Overclocking Issues (CPU & GPU Fan)

Note overclocking the system (making adjustments to the CPU//GPU Fan) by making alterations to clock frequency and/
or voltage may cause hardware damage, reduce system stability, the useful life of the system and affect system data integ-
rity. Therefore overclocking the system is enabled at the user’s own risk, and is not covered in the warranty terms.

Overclocking should only be enabled when powered by a plugged-in adapter, and not on battery power.

A warning will appear after you make any adjustments to the CPU/Memory/GPU.

Activating CPU/Memory Overclocking may reduce
system stability, useful life of the system and affect
syslem data integrity.

Cancel

System Errors

If you get any system errors, to reset the computer you can press and hold the power button to force the system to shut-
down. To restart press and hold the power button while holding down the Fn + D key combination (for the CPU reset
or Fn + G for the GPU reset).The overclocking settings will be OFF after restart.

.|
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Basic Setting
The Basic Setting alows you to adjust the power mode and other system features.

C CONTROL CENTER 5.0
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Enterainment

Figure B - 5 - Basic Setting & Power Modes

Power Modes
Y ou can set aPower M ode by clicking the appropriate icon in the center of the Control Center. Each pow-

er mode will affect Airplane Mode and PC camera power.

* InPower Saving Mode the Airplane M ode will be ON and the PC Camera will be turned OFF.

* InQuiet Mode the Airplane Mode will be OFF.
* In Performance Mode and Entertainment Mode the Airplane M ode will be OFF.

» Clicking the Default button in Entertainment will reset the default settings for this mode.

.|
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Power Status /
The Power Status icon will show whether you are currently powered by the battery, or by the AC/DC adapter

plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness 82\
The Brightness

icon will show the current screen brightness level. Y ou can use the dial to adjust the screen brightness, or you
can use the Fn + F8/F9 key combinations.

PC Camera/Touchpad/Left Windows Key
Click these buttonsto toggle the PC Camera or Touchpad power status, or to turn the L eft WindowsK ey func-
tionality on/off. The button under the icon will appear highlighted when it is enabled. Note that the power status
of the cameramodule is also effected by the Power M ode selected (see “ Power Modes’” on page B - 6).

Sleep / Hibernate Button
Click either the Hibernate or Sleep buttons to have the computer enter the selected power-saving mode (you
will receive awarning before the system switches to the power-saving mode and will need to click OK to con-

firm).
92
Volume =

The Volumeicon will show the current volume level. Y ou can use the dial to adjust the Volume or the Fn + F5/
F6 key combinations, or use the Fn+ F3 key combination to mute the volume.
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Caps Lock/Scroll Lock/Number Lock/Airplane Mode
Click the button to toggle the appropriate lock mode and
Airplane Mode. Note that Airplane Mode is not an indicator, and is not intended to display the current status
(check the LED indicator), but atoggle and can be overridden by one of the power modes.
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LED Device Menu

KB Sleep Timer / KB Brightness (for |lluminated White Keyboards)
Enable and then select the amount of time the system for which the system isidle before the keyboard LED en-
ters sleep mode (i.e. the LED keyboard illumination will turn off to save power). You can aso adjust the key-

board brightness.

\\-@ LED Device

3 KB Brightness

Sleep Timer
Enable

o
0

Figure B - 6 - LED Device (llluminated White Keyboards)

. |
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Keyboard Backlight LED Device (for llluminated Colored Keyboards) —

The Keyboard Backlight LED Device application can be accessed by pressing the Fn plus ‘*" | key (or by
clicking LED Device in the top left of the Control Center). The KB Sleep Timer and KB Brightness controls
are also available for White LED |lluminated keyboards.

\\?j) LED Device

£ LEDMode

Keyboard Al

TUE KB Brightness

« @)

i) KB Sleep Timer
Enable

H
o

Figure B - 7 - Keyboard LED Device Application (Keyboard All)

B - 10 LED Device Menu



Color Swatch

The color swatch in the middle of the screen allows you to select arange of colors for your keyboard backlight
by clicking on the color required. Click to select any colors from the swatch to apply to the whole keyboard (un-
der Keyboard All) or parts of the keyboard (under Keyboard Partial).

KB Sleep Timer
Enable and then select the amount of time the system for which the system isidle before the keyboard LED en-
ters sleep mode (i.e. the LED keyboard illumination will turn off to save power).

KB Brightness
Click on any of the numbers (1 - 4) on the KB Brightness bar to set the brightness level of the LED Device. Y ou
can aso turn the keyboard backlight LED Device off by clicking the OFF button, or by usingthe Fn plus " | key.

Figure B - 8 - Keyboard Color Swatch

LED Device Menu B - 11



LED Mode - Keyboard All/Keyboard Partial
Click either of the headings on the left under LED Mode (Keyboard All or Keyboard Partial) to select how
the colors will be applied.

» Keyboard All - Simply click a color from the outer band of the swatch, or click one of the color mixesfrom
the center of the swatch and it will beimmediately applied to the whole keyboard.

» Keyboard Partial - Simply click a color from the outer band of the swatch, or click one of the color mixes
from the center of the swatch, and then click one of the keyboard section headings (L eft, Mid or Right) to
apply the color.

VU CONTROL CENTER 2.0

Figure B - 9 - LED Mode - Keyboard Partial
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Keyboard Effects
Click on Keyboard Effect (under LED Mode) and then click any of the Effect buttons to view the effects on
the keyboard.

€5 LEDMode

B =20 d A& K

Wave Breath Cycle Random Dance Tempo
Figure B - 10 - Keyboard Effects

LED Device Menu B - 13



Extra Setting
The Extra Setting tab allows you to adjust the app skin color to your choice.

o
3w Change Skin Color
el

Figure B - 11 - Extra Setting

B - 14 Extra Setting



Flexikey® Application

Click FlexiK ey in the top left of the Control Center to access the Flexikey® application. Y ou can use the Fn
+ Backspace key combination to toggle the Flexikey® application on and off.

Profiles

The controls at the top right side of the application relate to Profiles. You can Add/Delete Profiles (you can
maintain 12 active Profiles), Export and Import profiles by clicking on the appropriate icon. If you double-
click on aProfile you can change the Pr ofile Name, and import an | mage file (images created using PNG files).

N\ AL/
L&
Windows Key F
Fn & P Keys

(s Ay Mol

Note that you can
assign actions to

any keyboard key
except the Win-
dows key F Fn
and P key.

Macro Keyboard

Figure B - 12 - Flexikey® - Profiles (Macro Keyboard)

.|
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Flexikey® Application Features

« EXPRESSKEY - Thisfeature allowsyou to configure asingle key to send multiple key combinations or to
create more useful shortcut keys. Thisis useful in gaming or when using applications which have a complex
set of keyboard shortcuts.

» LAUNCH APP - Thissimply assigns single keysto launch any program’s or application’s executablefile.
» EXPRESSTEXT - With thisyou can assign single keys to send commonly used strings of text.

* DISABLE - Usethisfunction to disable any keyboard keys.

» STATISTICS - Use thisto quickly record keysin use in any application, and to disable unused keys.

Macro Keyboard and Macro Mouse Settings
Click Enable el (at the bottom right of the screen) to create settings for the keyboard and/or mouse

Enable

by clicking the tab at the bottom of the screen (e.g. you may wish to create a profile with settings only for the
mouse or keyboard). Clicking on M acro K eyboard or Macro M ouse allows you to access the settings page for
the either the keyboard or mouse.

Macro Keyboard

Figure B - 13 - Macro Keyboard & Macro Mouse Selection
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Enabling or Disabling Flexikey®

Y ou can enable or disable Flexikey® (and therefore any hotkeys or mouse profile functions currently in use) by
using the Fn + Back space key combination. Pressing this key combination will toggle you between the currently
selected keyboard or mouse profileto the standard keyboard and/or mouse settings, and back again. An on screen
icon will also pop-up to display the status of the application asit is toggled on/off.

i, Flexikey* ON
L3 af}
r 3

Figure B - 14 - FlexiKey On Screen Icons

.|
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Keyboard Settings

The keyboard settings allow you to configure actions for any single key (or a combination of keys). Click the
key and then select the action type (ExpressK ey, Launch App, Express Text or Disable) from the menu at the
top of the page. You can click in Tool Tipsto type in anote to remind you of the action’s function.

\ A/
Z &
Windows Key H-
Fn & P Keys

C CONTROL CENTER 2.0

Usa Fi
‘II |62 o
Exproas Nisabie

proas Tex

Note that you can

assign actions to
any keyboard key
except the Win-
dows key F Fn
and P key.

Macro Keyboard

Figure B - 15 - Macro Keyboard Configuration

.|
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Mouse Settings

When an external mouse is attached, the mouse settings allow you to configure actions for the left @, right @
and middle @ buttons of the attached mouse, and also for any backward @ and forward @ buttonsiif appli-
cable (on agaming type mouse). Click the button number and then select the action type (ExpressK ey, Launch
App, Express Text or Disable) from the menu. You can click in Tool Tipsto typein a note to remind you of
the action’ s function.

VY CONTROL CENTER 2.0

FloxiKoy
e | 4

Expross Key Launch APF Expross Tuxd Ussabke

Macro Mouse

Figure B - 16 - Macro Mouse Configuration
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Keyboard Settings - Express Key
To configure asingle key to send multiple key combinations, or to create more useful shortcut keys, use Express
Key.
1. Enable and select the keyboard under your chosen profile, click on the chosen key to select it, and then click to
select Express Key.
C CONTROL CENTER 2.5

Spent Pl

Fexiey
: amsmmce | UBE FrsBackspace 1o Enable
+ | = or Disnbila Flaxikey
pres

|EEER 1 ounch APP

f_',- Restorn

Macro Keyboard

Figure B - 17 - Control Center - Macro Keyboard - Record Express Key
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2. Inthe following example we want to change an existing game key configuration which uses the left shift key for
sprinting, and the W key for moving forwards, to use the left Ctrl key to combine this movement to sprint
for_ward. - o _ _

3. Click the Record button and then press the key or keys (in this case we will press Left Shift and W)
required (make sure you press the key(s) required and do not click on them).

4. Click the Record buttonh again to complete the process and stop recording.

5. Click on the key, and then click in the Tool Tips field and type to give the key combination a name e.g. “Sprint
Fwds”.

6. If you want to remove any individual key click to select it, and then click Restore.

7. Any assigned Express Keys will be highlighted in green.

4

Tool Tips

The Tool Tips field allows you to type a note to remind yourself of the function you have programmed the key for under
any Profile.

.|
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Enabling Delay Time
If you want to create a delay between key presses within the key combination, then you can use Enable Delay
Time function to do so.

1. Enable and select the keyboard under your chosen profile, click on the chosen key to select it, and then click to
select Express Key. —

2. Click the Record button and then press the key or keys required in the sequence and time delay
between key presses required (make sure you press the key(s) required and do not click on them).

3. Click the Record button C again to complete the process and stop recording.

4. Click to select a key in the sequence and click Enable Delay Time , then click a key to view
the time delay.

P COoONTROL CENTER 2.5

Figure B - 18 - Enable Delay Time
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5.  You can edit the delay between key presses by clicking in the Delay Time (MS) field and typing a new number
for the delay between the key presses.

Action Delay Time

(mS)

Figure B - 19 - Time Record Between Key Presses

6. If you want to remove any individual key click to select it, and then click the delete . symbol.
7. If you want to clear all the settings click Restore to return to the default key setting.
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Keyboard Settings - Launch App
Y ou can configure keys to launch any application or program as follows:

1. Enable and select the keyboard under your chosen profile, click to select a key to launch the application, and

then click to select Launch App.
2. Click Browse... at the bottom left of the application window.

L. Lecal Diak [C)
= DaTa

- | ExE Files e

(o] oo

Macro Keyboard

Figure B - 20 - Macro Keyboard - Launch App (Browse to Executable File)
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3. Navigate to the executable file of the application and click Open.
4. The key will now be configured to open the selected application under your chosen Profile, and the key will
appear in red.

C CONTROL CENTER =.0

CAProgram F ol Explorer

Macro Keyboard

Figure B - 21 - Macro Keyboard - Key Set to Launch App
5. If you want to remove any Launch App Key, select it and click on Restore.
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Keyboard Settings - Express Text

A single key can be set to send a string of text within any application using Express Text.

1. Enable and select the keyboard under your chosen profile, click to select a key, and then click to select Express

Text.

2. Click in the Text Context field and type in your message and click Save.

3. Click the Record button in Start key and press the keys to use if required (the Start key is the key used to in
your target program to open a text message), or you can leave it blank if you prefer. Click the Record button

again to stop the process.

Macro Keyboard

Figure B - 22 - Macro Keyboard - Express Text

.|
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4. Click the Record button in Send and press the keys to use if required (the Send key is the key used to in your
target program to send a text message e.g the Enter key would be the most commonly used), or you can leave
it blank if you prefer. Click the Record button again to stop the process.

5. The key will now be configured to send the text message in the target program under your chosen Profile, and
the key will appear in blue.

6. If you want to remove any Express Text key, select it and click on Restore.

SN
L&

Copy & Paste Text

Note that some applications and games do not support copy and pasted text. Where this is the case, any text you may have
copy and pasted in to the “Type to Text” field may not be displayed within the application. In this case you will need to type
the text into the field instead.
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Keyboard Settings - Disable
Y ou can use the program to disable any keys not required.

1. Enable and select the keyboard under your chosen profile, click to select a key to disable, and then click to select

Disable.
2. The key will now be disabled.
3. If you want to enable the key again, select it and click on Restore.
4. The key will be disabled under your chosen Profile, and the key will appear in Gray.

CCONTIROL CENTER 2.0

Macro Keyboard

Figure B - 23 - Macro Keyboard - Disable
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Mouse Settings - Express Key

To assign a mouse button click to send multiple key combinations (an external mouse must be attached), or to
create more useful shortcut keys, use Express Key.

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Express Key.

2. In the following example we will configure the central mouse wheel to combine the actions of left shift key for
sprinting, and the W key for moving forwards in a game program.

3. Click on the central mouse wheel for the shortcut action.

¢ CONTROL CENTER 2.0

Figure B - 24 - Macro Mouse - Express Key Record Key Combination (Mouse)
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8.
9.

Click the Record button and then press the key or keys (in this case we will press Left Shift and W)
required (make sure you Eress the key(s) required and do not click on them).

Click the Record button again to complete the process and stop recording.

Click on the key, and then click in the Tool Tips field and type to give the key combination a name e.g. “Sprint
Fwds”.

Click in the Tool Tips field and type to give the key combination a name e.g. “Sprint Fwds”, then click back in
the Name field (to avoid adding the recorded keys to the Tool Tips hame).

If you want to remove any mouse setting click to select it, and then click Restore.

The mouse button for any assigned Express Keys will appear in

Enabling Time Record for Mouse Settings

If you want to create a delay between key presses within the mouse click combination, then you can use Time
Recor d function to do so in the same manner asthat used for keyboard settings (see“ Enabling Delay Time” on
page B - 22).
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Mouse Settings - Launch App

Y ou can assign a mouse button click to launch any application or program as follows:

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Launch App.
2. Click Browse... at the bottom right of the application window.

4

Macro Mouse

Figure B - 25 - Macro Mouse - Launch App (Browse to Executable File)

.|
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3. Navigate to the executable file of the application and click Open.
4. The mouse click will now be configured to open the selected application under your chosen Profile, and the
button will appear in red.

FlexiKey
. | UseFn+Backspace fo Enable
E + or Disable Flexikey

Express Key Launch APP Express Text Disable

Middle

C:\Program Files (x86)\internet Explorer
\iexplore exe

i
Enable

Macro Mouse

Figure B - 26 - Macro Mouse - Button Set to Launch App
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Mouse Settings - Express Text
A mouse button click can be set to send a string of text within any application using Express Text.

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Express Text.

2. Click in the Text Context field and type in your message and click Save.

3. Click the Record button in Start key and press the keys to use if required (the Start key is the key used to in
your target program to open a text message), or you can leave it blank if you prefer. Click the Record button

again to stop the process.

Macro Mouse

Figure B - 27 - Macro Mouse - Express Text

.|
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4. Click the Record button in Send and press the keys to use if required (the Send key is the key used to in your
target program to send a text message e.g the Enter key would be the most commonly used), or you can leave
it blank if you prefer. Click the Record button again to stop the process.

5. The key will now be configured to send the text message in the target program under your chosen Profile, and
the key will appear in blue.

6. If you want to remove any Express Text key, select it and click on Restore.

SN
L&

Copy & Paste Text

Note that some applications and games do not support copy and pasted text. Where this is the case, any text you may have
copy and pasted in to the “Type to Text” field may not be displayed within the application. In this case you will need to type
the text into the field instead.
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Mouse Settings - Disable

Y ou can use the program to disable any mouse button clicks if not required.

1.

2.
3.

Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Disable.

The button click will now be disabled.

If you want to enable the button again, select it and click on Restore.

The button click will be disabled under your chosen Profile, and the key will appear in Gray.

Y CONTIROL CENTER 2.0

Macro Mouse

Figure B - 28 - Macro Mouse - Disable
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Statistics

The Statisticstab allows you to record keys used in any application, and to disable any infrequently, or unused,
keys to save any accidental incorrect key presses.

1. Click the Statistics Tab, and press the Record button to start recording the frequency of key presses for keys used.

2. You can then go to the application for which you wish to use the profile, and use the application as per normal
so that a standard set of keys used may be recorded.

3. Return to the Flexikey® application and press Record button again to stop recording.

4. Atthe end of the recording process colors will represent the frequency of key presses, with the darker keys as

the most frequent through to lighter the less frequent (the color dial on the left of the screen displays the color

code against the number of key presses).

You can move the mouse over any key to see the number of times it has been pressed.

6. If you want to disable a key click Quick Disable and click the keys you wish to disable (the key will become
grayed out) and then click Save to retain the settings.

o
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Figure B - 29 - Statistics

B - 36 Statistics



Video Driver Controls

Appendix C: Video Driver Controls

Video Driver Installation

Video (VGA)

1. Click 2.Install VGA Driver > Yes.

2. Click Next > Yes> Next > Next.

3. Click Finish to restart the computer.

4. Intel Graphics Control Panel will download but you will need to have a
working internet connection.

5. Click the Sart menu in Windows to access the Microsoft Sore App tile

under Explore.

Click the Sign in icon &, and select Downloads and updates.

Click Check for Updates and alist of apps being downloaded will pop-up.

8. To prioritize the driver you can click Pause all and pause the other drivers
download queue.

9. Click onIntel Graphics Control Panel and click on the resumeicon O to
download the driver.

10. When finished the I ntel Graphics Control Panel will appear in the Win-
dows Sart menu.

N o

Note: After installing the video driver go to the Display/Display Settings control
panel to adjust the video settings to the highest resolution.

Video Driver Installation C - 1

4

Video Card Options

Note that this computer
model series may support a
range of CPUs and/or vid-
eo adapters.

To get information on your
system’s video adapter go
to the Start menu and se-
lect Settings, and then se-
lect System and click
Display> Advanced dis-
play settings > Display
adapter properties.

Note that card types, spec-
ifications and drivers are
subject to continual up-
dates and changes. Check
with your distributor/suppli-
er for the latest details on
video cards supported.



Video Driver Controls

NVIDIA Video (VGA)

1.
2.

3.
4.

5.

Click 3.Install NVIDIA VGA Driver > Yes.

Click AGREE AND CONTINUE (button) to accept the terms of the
license agreement.

Click Next.

Restart the computer and run the application again after restart.
Go to the Microsoft Store to download the NVIDIA Control Panel.

Note: After installing the video driver go to the Display/Display Settings control
panel to adjust the video settings to the highest resolution.

NVIDIA Apps

1.
2.

3.

o &

Click 4.Install NVIDIA Apps> Yes.

Click AGREE AND CONTINUE (button) to accept the terms of the
license agreement.

Click Next.

Click Close to complete the install ation.

After all the drivers have been installed (an internet connection is required)
run the NVIDIA GeForce Experience by clicking the desktop icon [ig (or

App).
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Video Driver Controls

Microsoft Hybrid Graphics

Most notebook computers come with either a discrete or integrated graphics solu-
tion.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU)
which are capable of playing games, watching HD video or running GPU-based ap-
plications. However computers with discrete graphics solutions tend to be heavy in
power consumption, and slightly larger in size in order to incorporate the dedicated
discrete GPU.

Integrated graphics solutions usually feature memory sharing technology to help
save power consumption and allow for longer battery life. However computers with
integrated graphics solutions will not usually run games, HD video or GPU-based
applications without severe limitations.

Microsoft Hybrid Graphicsis a seamless technology designed to get best perfor-
mance from the graphics system while allowing longer battery life, without having
to manually change settings. Thus when an application isrun that requires extra per-
formance or quality, then the system will run the discrete GPU (dGPU); when the
system does not require such enhanced performance it will let the integrated (iGPU)
handle it.

.|
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Video Driver Controls

4

Customization
Options

Although Microsoft Hy-
brid Graphics is com-
pletely seamless to the
user, NVIDIA also allow
customization  options
within the control panel.

How the Technology works

When the system is powered up and is displaying just the desktop, the dGPU will be
powered off. In this case the system is running in the same way as a system without
a discrete graphics solution. However when an application that requires use of the
dGPU isrun (e.g, agame or HD Video), the dGPu is powered on and takes over the
processing duties. If the program is closed, then the dGPU will be powered back
down again until required.

C - 4 Microsoft Hybrid Graphics
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4

VR Headsets

4

Mini Display Ports / HDMI Port

All external and internal displays (up to 4 active displays) can be configured from Win-
dows by using System (in Settings - page C - 7) control panel, or the == + P (or Fn +
F7 - page C - 6) key combination. It is recommended that you use the Windows controls
to configure multiple displays. in addition you can use any of the following to configure ex-
ternal displays attached to a particular port. In addition to the Windows controls, use any
of the following to configure external displays attached to a particular port.

Note that this comput-
er supports virtual re-

ality (VR) headsets,
however VR headsets
must be connected to
the Mini Display Port
Mini DisplayPort 1.2 o; If you wish to configure an external display connected to Mini 13 9
DisplayPort 1.2 you will need to use the Intel HD Graphics control panel menu to con-
figure the display configuration.

Mini DisplayPort 1.3 9: If you wish to configure an external display connected to Mini

DisplayPort 1.3 you will need to use Project Menu, Display Settings in Windows (see

Figure C - 3 on page C - 7) or the NVIDIA Control Panel (see “NVIDIA Control Panel” Figure C-1
on page C - 32) to configure the display configuration.

) : : - Left Side View
HDMI Port 6: If you wish to configure an external display connected to the HDMI Port ini Displ
you will need to use the Intel HD Graphics control panel menu to configure the display (Mini DisplayPorts
configuration. & HDMI Port

In a multiple display environment, external displays connected to Mini DisplayPort 1.3 9 Highlighted) -
will be in Extended mode only. Single Model

Pictured

Microsoft Hybrid Graphics C - 5



Video Driver Controls

Configure Other Displays Using Project

Y ou can configure attached displays from Proj ect.

1.
2.
3.

FigureC- 2
Project

Attach your display to the appropriate port, and turn it on.

Press the g@ + P key combination.

Click on any one of the options from the menu to select PC screen only,
Duplicate, Extend or Second screen only.

You can also click Connect to a wireless display at the bottom of the Project
screen and follow the steps to connect to any wireless enabled display.

Project

PC screen only

Duplicate

Second screen only

C - 6 Configure Other Displays Using Project



Video Driver Controls

Configuring an External Display In Windows

The System > Display Control Panel in Settings may also be used to configure dis-

plays.

1. Attach your external display to the appropriate port, and turn it on.

2. Click the Start Menu and click Settings > System (or right-click the desktop and
select Display Settings).

3. Click the Multiple Displays menu and select Duplicate these displays, Extend
these displays or Show only on 1/2 etc.

4. Click Keep changes to save any changes made.

----- Display
. B fisme Display

e e Figure C - 3
s iy System > Display
(Multiple Displays)

Multiple displays

= 2 Make Windows better
Duplicate these displays "

Extend these displays
Show only en 1

Show only on 2

.|
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Video Driver Controls

5. You can configure up to 4 displays from the System > Display menu.

4

& Settings - o X

4 Connected 03 SYSTEM I Find a setting =
Displays -

. Customize your display
Note that when 4 dis-

plays are connected,
only 2 displays may be Apps & features
configured in Duplicate

mode. Mulitasking 2
Tablet mode - -

Notifications & actions

Ballery saver
FigureC-4 oa
System > DlSplay Identify Delect
Storage ; .
(4 Connected :hange the size of text, apps, and other items: 100% (Recommended)
Displays) Offline maps ¥
Orientation
Default apps \ |
Abaut

Duplicate desktop on 1and 2

Duplicate desktop on 2 and 3

Duplicate desktop on 2 and 4

Disconnect this display

ke 1S my main aispiay

C - 8 Configuring an External Display In Windows



Video Driver Controls

HDMI Audio Configuration

HDMI (High-Definition Multimedia I nterface) carries both audio and video signals. _
In some cases it will be necessary to go to the Sound control panel and manually VIme A RTSmETS
configure the HDM I audio output as per the instructions below. The sound volume level
can be clicking using the
Go to the Sound control panel. volume control icon [:]:I::l':|
Click Playback (tab) in the notification area
The playback device will be selected. of the taskbar.

You may need to select the audio device and click Set Default (button).
Double-click the device to access the control panel tabs.

LR

& Sound x

Flayback Recording Sounds Communications

Select a playb

: SyncMaster-C Flgure C = 5
-l NVIDIA High Definition Audio
e Ready _

- = 2y Sound HDMI

9 oeraut Devce Device (set Default)

g
— e
oK Cancel Apply

.|
HDMI Audio Configuration C - 9
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o

Adjust the HDMI settings from the control panel tabs.
7. Click OK to close the Sound (¥ control panel.

W SymcMaster-C Properties = W SyneMaster-C Properties b4

Ganeral Supperted Formats Levels Crhancements Advancsd Gararal Sopported Formals Lavels Enhancements  Advasced

i — [ e

Change |can
T R The fallawing aucka fermats are currently supporad
M Hursiar of Channets:
@J MvIDas High Definkion Auds Broperties.
HOCP: Supported
: i Depith: 16
28
[
Jack informatian Sample fiates:
LR HDMI Digeal Jack e
48.0 4z
Encaded Foemay:
Mo compressed formats found
Device usage: Use this device (anabie) v

FigureC-6 | o] [ | R | ) e
HDMI Device - syt C properes x S — z

Gereral Supported Formats Levels Enhancements Advanced

Properties B T e e

«configuration. Changes may not take effect until the nest tme you start
nck,

Garval Supported Formats Levels Enhancemarts Advanced
Default Format

Sedect the sample rabe and bit degith 1o be uied when nanning in

shared mads.
[Cnisabie & anhsmcements
& e vy Promncice] 16 bl 46000 s VD Gty ][ e
] Room Correctien 16 bt 44100 Hz (0 Cuakty)
16 it AB000 Ha (DD Qualkiy
[ Loudness Bqualisation

24 it 48000 1z [Sruchs Qualit

[T allow apphications to take excluswve contral of this device
Ertmncame FYoprtien [ G wxclusive mode sppbeations priorty
Duserytion: Lan Fragusncy Pratuction alenates Fregquentin

below o specfied cutoff 1o reduce audio distortion

Provider: Microsoft
Sentus: Dinabled Setnga...

Bestore Defaus B ereview [
Festore Qefaults
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HDMI Notes
» Connect adevice with HDMI support to the HDMI-Out port BEFORE attempt- A
ing to play e_\udl o/video sources through the de_'w ce. Other Applications
» To play audio sources through your external display’s (TV or LCD) speakers . .
you will need to go to the audio configuration control panel on the display and If you are using a third
configure the audio input accordingly (see your display device manual). gﬂgsagg'cf?g;" ;?];':z
» Notethat the Sound Blaster Ci nema audio effects do not apply to audio gener- tached DVD device,
ated through an HDMI connection. you will need to consult
) ] ) the application’s docu-
HDMI Video Configuration mentation to see the
1. Connect an HDMI cable from the HDMI-Out port to your external display. appropriate audio con-

2. Configure your external display as per the instructions in “Attaching Other | figuration (the applica-
Displays” on page C - 29. tion must support_digital

3. Set up your external display (TV or LCD) for HDMI input (see your display device | t© analog translation).
manual).

4. You can now play video/audio sources through your external display.

.|
HDMI Audio Configuration C - 11
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4

Compatible
Adapters

For a list of compatible
adapters check the vid-
eo adapter/display de-
vice documentation, or
with  your distributor/
supplier.

Wireless Display

Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo mod-
ule (you need to make surethat your video adapter/display deviceiscompatible
with your particular WLAN/Combo module) in conjunction with a compatible
video adapter/display device (purchased separately) to allow you to display the
contents of the notebook display on another display (e.g. HDTV), without the need
to have cables stretching across a room.

Y ou can use the wireless display to play games, browse the internet, display videos
or photo slide shows on your TV/external display without using HDMI or A/V ca-
bles.

Before configuring Wireless Display you will need to set up your compatible
adapter with your display/speakers. Connect the adapter usingan HDMI or A/V ca-
ble and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compat-
ible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 10.

C - 12 HDMI Audio Configuration
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Wireless Display Configuration

1. Note that no driver or application is required for wireless display in Windows 10.

2. Pressthe g@ + P key combination.

3. Click Connect to a wireless display at the bottom of the Project screen and
follow the steps to connect to any wireless enabled display.

Project

PC screen only

Duplicate Flgure C - 7
Add a Wireless
Display

Second screen only

4. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).
5. Double-click any detected display device in the list.

Wireless Display Configuration C - 13
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6. You may then need to input a pin number for the device to which you are
connecting and click Next.

7. The display will then connect (for specific settings for your display see the
documentation supplied with your compatible adapter/display for full details).

8. Go to the Project menu and click Disconnect to temporarily disconnect from the
wireless display.

9. To permanently disconnect from the display (you will need to go back through the
connection process again) you can select it in Devices and click Remove Device
> Yes.

C - 14 Wireless Display Configuration
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Intel® HD/UHD Graphics Control Panel

Advanced video configuration options are provided by the Intel®@ HD Control Pan-
el. Use the Intel®@ UHD/HD Control Pane to configure external displays at-
tached tothe HDMI Port and Mini DisplayPort 1.2. To access the control panel
see below and overleaf. FigureC - 8

1. Access the Intel Graphics Control Panel from the Start menu in Windows. Intel® Graphics
Control Panel

= (right-click to Pin to
Sound Blaster Connect See all your mail in one place o O
e m = taskbar)
And more.. E

& Calendar Mail

Recently added

) ¢

Ea 3D Viewer

A

Alarms & Clock

&

E Calculator

@ Microsoft Edge

Play your
¢ favorite music
- for free.

Spotify ©  Skype

0@

OR

Intel® HD/UHD Graphics Control Panel C - 15
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2. You can right-click the Intel Graphics Control Panel in the Start menu and pin
the control panel to the taskbar.

Recently added
;__? Sound Blaster Connect See all your mail in one place
FigureC-9
. Video Editc E
Intel® Graphics _ R ©AndEnEI:re...
Contr0| Pan el i[_PJ Intel® Graphics Control Panel i S iy

(right-click to Pin to -2 Pin to Start —

Expand ~
taskbar)

Mo
ore Pin to taskbar

]E Uninstall

3D Viewer Run as administrator

App settings
Rate and review

Alarms & Clock
Share

ﬁ Remaowe from this list

Calculator o - o
Microsoft Store Clear list

A Calendar Mostly Clear
3. OR
Use the Ctrl + Alt + F12 key combination shortcut to open the Intel Graphics
Control Panel.

C - 16 Intel® HD/UHD Graphics Control Panel



Y ou may make changes to any of the graphics properties by clicking the appropriate

menu panel and adjusting the settings from the menus.

Better Environment

Display

AME FOR INTEL GRAPHICSV

tailed Characters. More Exating Effects.

Video

EEQHJ‘&:

Gaming Pawer Options and
Support

Intel® HD/UHD Graphics Control Panel C - 17

Video Driver Controls

4

Home

Click the Home button to re-
turn to the main menu
screen in any of the sub-
menu screens.

Intel® Dynamic Video
Memory Technology

Intel® DVMT automatically
and dynamically allocates
as much system memory
(RAM) as needed to the in-
tegrated video system (the
video driver must be in-
stalled).

DVMT returns whatever
memory is no longer need-
ed to the operating system.

FigureC- 10
Intel® UHD Graphics
Control Panel
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Display
Z Click either General Settings or Color Settings to make display adjustments, in-
Multiple Display cluding configuration for any attached external displays.

1D ¢

At least one other dis-

play must be attached in
order to view multiple
display selection op-
tions.

FigureC- 11
Intel® UHD/HD
Graphics
Control Panel -
Display

C - 18 Intel® HD/UHD Graphics Control Panel
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Click the Display menu at the top of the screen to display the sub-menus. The Mul-
tiple Displays menu alows you to configure the display mode of any attached dis- Z
plays (see “ Attaching Other Displays’ on page C - 29). Click Apply to save any
changes made.

Multiple Display

At least one other dis-
play must be attached in

Intel® UHD Graphics Control Panel

(® Display order to view multiple
display selection op-

General Settings Select Display Mode @ tions.

Color Settings single Display

T Audio Settings
Custom Resolutions S - Any attached active dis-
Select One or More Active Displays plays must have audio
capacity to allow audio

Built-in Displey v configuration.
Select Profile LRl DepiayiSyno ety =
Curret settings <
FigureC- 12
Intel® UHD/HD
Graphics

Control Panel
Display - Multiple
@ Displays

Save Profile

Intel® HD/UHD Graphics Control Panel C - 19
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FigureC- 13
Intel® UHD/HD
Graphics
Control Panel
Display Settings -
Custom
Resolutions

@ Display

General Settings
Color Settings

Multiple Displays

Custom Resolutions

Select Display

Built-in Display ~

Add Remove

Width

Height

i

Refresh Rate

Underscan Percentage

Resulting Resolution: 0x 0, 0 Hz.

24

The Custom Resolutions sub-menu alows you to adjust the display (or any at-
tached display) to any width, height, refresh rate, color depth and underscan percent-
age of your choice. Note that incorrect settings can cause system instability and even
possible component damage, so thisis adjusted at your own risk.

Intel® UHD Graphics Control Panel

Help
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3D

This menu allows you to choose how 3D images are displayed. Perfor mance gives
the smoothest motion of images, Quality displays the most detail, Balanced M ode
provides better computer performance with good quality and Custom allows you to
configure the Anisotropic Filtering and Vertical Sync and features to your prefer-
ences. Click Apply to save changes.

Intel® UHD Graphics Control Panel

® 3p

Application Settings salect Application i} Conservative Marpholegical Anti-Aliasing Fl gure C = 14
Global Settings (=) Agplications with default 30 settings Override Applicaticn Default Sattings Intel® UHD/HD
Mo application found. Bress Browse to find more ag T — G hi
hance Application Default Sefting, raphics
W Tum Gff
Control Panel 3D
© » sLitti-Sample Anti-Aliasing

v Lise Application Default Settings

Tarm ff

wertical Syne
Anisatropic Filtering

@
W Use Application Default Settings
v Use Application Default Settings
Liga Difiver Sattings ( :
%
an
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Options and Support

Hot Key Manager in Optionsand Support allowsyou to create hot keys for open-
ing the application and scaling etc. Click Apply to save changes.

Intel® UHD Graphics Control Panel e
@ Options and Support (intel
Information Center Restore Graphics Defaults @
=Ctrl> <Alt>F8
Preferences
Manage Hot Keys @
S rt
. “aila ' Enable Disable
FI gure C - 15 Toggle Scaling
Intel® UHD/HD prg
. Open Intel® UHD Graphics Control Panel
Graphics Sz Erafis P
Control Panel Current ettings -
Options and
Support

®

Save Profile
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Click the Options menu at the top of the screen to display the sub-menus. The In-
formation Center provides details on System Information, the Built-1n Display
and any attached displays.

Hot Key Manager
Preferences

Support

Select Option

System Information

Information Center

S0

Intel® HD Graphics Control Panel
@ Options and Support

Int2l(R) FC Graohizs 630

Report Date!

Report Time [Fh:mmsz]:
Driver Version:

Qperating Sysiem:

Physical Mamary:
Vendor [D:
Devica Ix
Devica Hevision

Graphics Cutput Protaccl (GOP)
Veision

Current ResolLtion:

Tuescay, November

22,2016
12:21:36 PM
2120164521

Windcws" 10 Fro
(10.0.10586)

S40) MiE
2095
591B

04

9.0.1053

1920 % 1080

Processor:

Processar Speed:

Processor Grephics in Usa:

Shader Versicn:

OpentL Vsrsion:

Microsoft Cirectx™

niel(R] Corz(Th]
570K cry @
2.50GHz

249F MH7

nite [#] HD Graphics
530

5

3

Runtime Verson:

I largwiare-Supported Yeision:

120

120

FigureC - 16
Intel® UHD/HD
Graphics
Control Panel
Options -

Information Center
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FigureC - 17
Intel® UHD/HD
Graphics
Control Panel -
Video
(Color
Enhancement)

Video
The Video menu allows you to brighten or darken movies, or to switch to vivid col-
ors. The Preview image will display a sample image using the current settings. Y ou
can Save Profile and name the Profile to recall the settings at any time. Click Apply
to save changes (select Color Enhancement or Image Enhancement from the
menu).

Intel® UHD Graphics Control Panel

@ Video

Color Enhancement Standard Color Carrection

W' Use application Default Settings
Image Enhancement Preview

Use Driver Settings

CAWINdowWSystemInDri..

Input Range
v Use Application Default Settings

riter Settings

Select Profile Total Color Comection

Current Settings ~ Enable W Disabie

C - 24 Intel® HD/UHD Graphics Control Panel



Video Driver Controls

Click the Video menu at the top of the screen to display the sub-menus.The I mage
Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhance-
ment, Noise Reduction, Contrast Enhancement and Film M ode Detection. Click
Apply to save changes.

Intel® UHD Graphics Control Panel ; )
Sl @ FigureC- 18
Intel® UHD/HD

Color Enhancement Grap hics

v Use Application Default Settings ) o CO ntro I Pan el - V| d eo
Preview B

]

Use Driver Automatic Settings
(Image
Use Driver Custom Settings C\Windows\System32\Dri...
Enhancement)
Skin Tone Enhancement @
v Enable Disable
|, 3
Select Profile a
Noise Reduction @
Current Settings b

Use Application Default Settings
VUse Driver Automatic Settings

Use Driver Custom Settings

Contrast Enhancement @

v Enable Disable
— ], 5

Film Mode Detection @

Save Profile
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Power
The battery life can be extended through dynamic control of the frame rate if Ex-

tended Battery Life for Gaming is enabled. Settings can be selected for when the
system is powered by battery or is plugged in.
Intel® UHD Graphics Control Panel

@ Power

Select a Graphics Power Plan Balanced Mode v @

Plugged In
Figure C-19 Global Settings
| nte|® UH D/H D Extended Battery Life for Gaming 16)
. v Enzble Disable
Graphics
Control Panel -
Power Select Profile

Current Settings

O

Cancel
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Video Driver Controls

Y ou can select one of the preset profiles (Brighten Video, Darken Video and En-
hance Video Colors) from the menu on the left. Alternatively you can go through
the menus to make adjustments to your preferences for Display, Color, Video, Op-
tions and Support and Power (tick any boxes for the settings required), and then
Save the settings to a profile (which may be imported or exported).

Intel® UHD Graphics Control Panel

@ Profiles

Select Profile Settings

- OoX

S}

Current Settings v
Display

W] color
video
Options and Support

W] Power

Figure C - 20
Intel® UHD/HD
Graphics
Control Panel -
Profiles
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N\ AL/
ZAS
4K 2K Videos on 4K2K
External Displays

Note you may experi-

ence some video lag
when playing 4K2K vid-
eos on an attached
4K2K external display.

TableC-1
Display Modes

Display Devices & Options

Note that you can use external displays connected to the HDMI-Out port and/or ex-
ternal monitor port and Mini Display (1.2) port. See your display device manual to

see which formats are supported.

Display Mode Description
One of the connected displays is used as
Single Display the display device (PC screen only or

Second screen only).

Clone/Duplicate

Both connected displays output the same
view and may be configured
independently

Extended /
Extend

Both connected displays are treated as
separate devices, and act as a virtual
desktop

Collage

A number of connected displays are
combined into a single unified higher
resolution for larger screen sizes

Hybrid

A number of connected displays are

combined and can be configured in a
combination of Clone and Extended

modes

4

Attaching Displays

When you first attach
an external display
you may find that the
desktop does not oc-
cupy the full screen

area. Use either the
display’s auto adjust/
configure controls, or
the Intel(R) HD
Graphics Control
Panel to configure
the full screen dis-

play.

C - 28 Display Devices & Options
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Attaching Other Displays

. e
To Clone Displays: _ .
1. Attach your external display to the appropriate port, and turn it on. Multiple Display
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >
Multiple Displays (sub-menu).

At least one other dis-

play must be attached in

3. Click Clone from the Select Display Mode menu. order to view Multiple
4. Click Apply, and OK to confirm the settings change. Display selection op-
5. Select the displays from the Select One or More Active Displays menu. tions.
Intel® UHD Graphics Control Panel

@ Display

General Settings Select Despley Mode

Color Settings singie Dpisy A

Multiple Displays FI gure C - 21

Custom Resolutions i DISplay > Multlple

s Displays (Clone)
Select Profile SR TR Sy =

Current Settings ~

Attaching Other Displays C - 29
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To Enable Extended Mode:

Z | 1. Attach your external display to the appropriate port, and turn it on.

2. Goto the Intel(R) HD Graphics Control Panel control panel and click Display >
Multiple Displays (sub-menu).

3. Click Extended from the Select Display Mode menu.

You can have different & 4. Click Apply, and OK to confirm the settings change.

Colors, Screen Area

and Monitor Refresh

Rates for each display

device provided your

monitor can support

them.

Display Settings
Extended Desktop

Intel® UHD Graphics Control Panel

@ Display

General Settings Select Display Mods Arrange Displays

Color Settings Single isplay

Clore Displiys

Multiple Displays

Custom Resolutions W' Extencied Destiop

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

FigureC - 22
Display > Multiple
Displays (Extended)

Salect One or More Active Displays

) Fremary Display
Buift-in Display -
[2]

2 s tal Display Synchasster ~
Select Profile b Lol

Curvent Settings ~

Click the appropriate monitor icon and drag it to match the physical arrange-
ment you wish to use (e.g. the secondary display may be extended left/right/

above/below the primary display).
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To Enable Collage Mode:

1. Attach your external display to the appropriate port, and turn it on. 4

2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >
Multiple Displays (sub-menu). Collage Mode

3. Click Collage from the Select Multiple Display Mode menu.

4. Click Enable Collage and click On. combine a number of

5

6

Collage mode is used to

Click Vertical or Horizontal to arrange and displays as required. displays into a single
Click Apply, and OK to confirm the settings change. unified higher resolution
for larger screen sizes,.

Intel® UHD Graphics Control Panel

@ Display

General Settings Select Display Mode i Aerange Displays

Color Settings Single Display

i Figure C - 23

Custom Resolutions e D|Sp|ay > Multlple
ok e e i A D ° Displays (Collage)

© Foimary Display
Digital Display VASDS v

(2]

Digital Television SyncMaster w
Select Profile 5]

Curtent Settings b Bualt-in Ditsplary N

Attaching Other Displays C - 31
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NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Access the NVIDIA Control Panel from the Start menu in Windows (or right-click
the desktop and select NVIDIA Control Panel).
2. To configure displays in Discrete mode use the NVIDIA Control Panel.

View > B WvIDIA Cantrol Panel
Sort by > File Edit Desktop 3D Settings Help
Refresh Qu -Q |0
P Select a Task.. . - = .
= ey .. Adjust Image Settings with Preview
S:FLS R el ; oy
~ }-Manage 30 settings “This page allows you to preview changes you make ta the mage and rendering settings, These wil
Fl gure C - 24 ‘ B \VIDIA Control Panel _Configure Surround, Physi herdware accslercted 3D applications that utiize Direct3D or OpenGL
Performance: Preview:

I 1 Display settings

NVIDIA Control
Pan el § & Personalize e

Quality:

 /
-I
What do T look for? Pause
Maving towards the (®) Let the 3D application decide
performance side wil
Tk SR (O Use the advanced 3D image settings ~ Take me there

but curved lines will (O Use my preference emphasizing: Quality
appear jaaned

Moving towards the
Quality side wil improve
the smoothness you
can see on aurved lnes

Desaription:
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The NVIDIA Control Panel provides additiona video configuration controls and

Video Driver Controls

tools which allow quick access to features such as image settings, 3D Settings and e

video configuration.

Navigating the

B3 nVIDIA Control Panel
File Edit Desktop 3D Settings Help

o X Control Panel

Qus ~Q | O

Navigate through the

Select a Task...

[5-30 Settings

[t image settings nith preview
+..Manage 3D settings
. Configure Surround, Physx

System Information

Adjust Image Settings with Preview

This page allows you to preview changes you make to the image and rendering settings. These will be your default settings for your

hardwars-accslerated 30 applications thal utiizs Direct3D or OpenGL.

Performance: Preview:

Quality:

What do I look for?

Moving towards the
Performance side will
increase frame rate,
but curved lines will
appear jagged.

(®) Let the 3D application dedide
(0 Use the advanced 3D image settings  Take me there

(7) Use my preference emphasizing: Quality

Maving towards the Rerformance
Quality sice will improve
the smoothness you

£an see on curved lines.

Description:

Typical usage scenarios:

Restore Defaults

= control panels in much
the same way as you
would a web page.

Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

FigureC - 25
NVIDIA Control
Panel
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The Help menus provide index and search features, and direct links to the NVIDIA

website etc.

FigureC - 26
Help Menu

&' NVIDIA Control Panel

- =
Hide Back Forward Home

Contents |ndex Search

@ Inroduction
@ Getting Started
@ Display

@ Workstation
@ Stereoscopic 3D
[2] Glossary

Print

<A NVIDIA. =

Control Panel

3D Settings - Games and Applications

Tasks in the 3D Settings pages allow you to do the following:

e Change the image and rendering settings of your 3D
applications and games that utilize Direct3D and OpenGL
technology.

® Assign specific 3D settings to = game so that these settings
automatically load when a game is launched.

® For systems and NVIDIA GPU-based graphics cards that are
capable of using NVIDIA Scalable Link Interface (SLI)
technology, you can enable this feature for significant

improvements in rendering performance of applications that
are based on Direct3D and OpenGL technology

These and other tasks are explained in the following sections:
® Adjust Image Settings
™ Manage 3D Settings
= NVIDIA Surround Configuration
m NVIDIA SLT Configuration

= NVIDIA Multi-GPU Configuration

m NVIDIA PhysX Configuration

[ NOTES for Optimus technology systems:

Some notebooks have special display connectors that are

driven by the NVIDIA GPU. Displays attached to these
connectors appear in the NVIDIA Control Panel Display

category pages. The NVIDIA GPU will always render the 3D W
cantent an these disnlavs. and vau can adiust various 20
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Further menu itemswill appear inthe NVIDIA Control Panel with external displays
attached to the Mini DisplayPort 1.3.

1 it s g i s

i

e

NVIDIA Control Panel C - 35
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NVIDIA Control

Panel

(with External Display
Attached to the Mini
DisplayPort 1.3)
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4

Display GPU
Activity lcon

Click to enable Dis-
play GPU Activity
Icon in the Notifica-
tion Area to quickly
access the GPU Activ-
ity monitor from the
taskbar.

EANVIDIA

FigureC - 28
NVIDIA Control
Panel - View

Customization Options

One of the most important aspects of hybrid technology isthat it will switch between
theintegrated GPU and discrete GPU seamlessly and automatically, and does not re-
guire any input from the user. However customization options are offered for users
who prefer to set their own parameters for GPU usage.

Context Menu
One of the quickest ways to choose which GPU to use for aparticular applicationis
by using the “Run with graphics processor” in the context menu.

1. Gotothe NVIDIA Control Panel.
2. Click Desktop from the top menu and select Add “Run with graphics
processor” to Context Menu (it should have a check alongside it).

MYIDIA Control Panel
File EdiDSettings Help

Bl Add Desktop Context Menu ‘

~  Show MNotification Tray lcon

Selecta Tas.l( W . . u
~  Add "Run with graphics processor” to Context Menu ) :
- 3D Setti : = : e — ge Setti ngs v
- Display GPU Activity lcon in Motification Area
é----ManagE 3D settings This page allows you to preview changes you make to
i.Configure Surround, PhysX hardware-accelerated 30 applications that utilize Direc
Performance: Preview:
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Close the NVIDIA Control Panel.
Find the executable file icon of the application you want to run.

Right-click the icon and select Run with graphics processor from the context

menu.

Select either High-performance NVIDIA processor (dGPU) or Integrated

graphics (iGPU) to run the program with the selected GPU.

Video Driver Controls

4

iGPU or dGPU

Note the NVIDIA con-

trol panel refers to
High-performance
] =1 Application Togls  Internet Explorer = o X NV|D|A processor
Home Share View Manage (2] h h . h .

« . A » ThisPC > Local Disk (C:) » Program Files (86) » Intemet Explorer ~ @ | Search Intemet Explorer -] (W IC IS t € dlSCfete
A ek nccess Mame - Date modified Type Size GPU) and lntegrated
Woscop  #  [lenls Filefolder graphics (which is the
§ Downloads - images File folder ]

I:] e + SIGNUP File folder Integra'te(j GPU)'
%= [ ExtExport Application 2%6KB
&= Pictures * = R =
[%] hmmapi.dil Application extens... 50 KB
BLWLAN [7] iegprops.propdesc PROPDESC File 3KB
Does & ieinstal \pplication 464 KB
Docs 2 ielowutil Application 217 KB
PEXRX [£] 1EShims.dil Application extens KE
i 2 iexplore . — : Annlicatinn
& Onelire %] sqmapi.dil ‘ Open ens... 224 KB
[ ThisPC r > i -
B Desktop Run with graphics processor >) High-performance NVIDIA processor FI gure C 29
= Bisatint Integrated graphics (default) .
[Z] Documents
Biois Pinto tstbar T Context Menu with
Restore previous versions L . .
e : : P ; Run with graphics
= P Right=click the application executablefile
B videos cu processor
ti, Local Disk (C:) Copy
= DATA (D2) Create shortcut
- MEMSTICK (E) & Delete
& Rename
£ Network
Properties
11 items 1 item selected 799 KB
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Video Driver Controls

Global Settings

4 .\ Global settings allows you to set the preferred graphics processor for overall use.
Customization Ideally thiswould be theiGPU for battery life, but this can be set to the dGPU if pre-
Options ferred.
Although hybrid tech- 1. Go to the NVIDIA Control Panel.
nology is completely 2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab).
seamless to the user, 3. Select either Integrated graphics (iGPU) or High performance NVIDIA
there are customiza- Processor (dGPU) from the drop-down menu.
tion options within the 4. Click the Setting menu items to select any options required.
control  panel (see 5. Click Apply to save the settings.
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Program Settings
Program settings allows you to make specific adjustments for installed applications.

1.
2.
3.

Go to the NVIDIA Control Panel.

Video Driver Controls

Click Manage 3D Settings (3D Settings) and select Program Settings (tab).
Select a program to customize from the drop-down menu, or click Add to add

any program that does not appear in the menu.

Select the preferred graphics processor for the program from the drop-down

menu.

Click the Setting menu items to select any options required.
Click Apply to save the settings.

ttngi_Heip

B

------

Manage 3D Settings

ot varntan Bn apaciic puagrmms Tha cvmides sl ks unecd utmsh sby sack be

Nerstors Defain

;;;;;

FigureC- 31
Program Settings
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Configure Surround, PhysXe

NVIDIA® PhysX® isa physics engine that can use the GPU to accel erate game and
3D application performance. Y ou can select the GeForce video card or CPU as a
PhysX® processor, or configure the computer to auto-select a PhysX® processor
(recommended default setting).

1. Go tothe NVIDIA Control Panel.
2. Click Configure Surround, PhysX.
3. Click to select a processor from the menu (PhysX Settings); Auto-select
(recommended) is the default setting.
4. Click Apply to save the settings.
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NVIDIA GeForce Experience -
If you have a working internet connection (and you will need remain connected NVIDIA GeForce
to the internet to run NVIDIA GeForce Experience) you can click the NVIDIA Experience
GeFor ce Experience desktop icon K< (or App) to run the application. Thiswill op- Version
timize your gaming settings for your NVIDIA GPU by downloading the latest set-

tings from the NVIDIA cloud data center. Hote that the NVIDIA

GeForce Experience
] ] application is subject
You may need to create an NVIDIA account to log-in to the system (alternatively BEECeREEREREIERG

you may be able to use your Facebook or Google account to log-in). update and revision,
so make sure you con-

nect and update regu-

: ] larly in order to get the
update your settings and check for installed games etc. latest settings and in-

formation.

After logging in to the system you can click through any on-screen instructions to

By running the NVIDI A GeFor ce Experienceyou will be able to download the lat-
est drivers to insure compatibility with games, power saving features and various
other enhancementsfor your NVIDIA GPU (these features are subject to change and
update so check with the NVIDIA website for the latest information).

Note that to enable BatteryBoost you must be connected to the internet.
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Specifications

Appendix D: Specifications
A

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.

Note that this computer model series may support a range of CPUs and/or video adapters.

To find out which CPU is installed on your system go to the Start menu and select Settings, and then select System and
click About. This will also provide information on the amount of Installed RAM etc.

To get information on your system’s video adapter go to the Start menu and select Settings, and then select System and
click Display> Advanced display settings > Display adapter properties.
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Specifications

Mobile Intel® HM370 Express Chipset

Models A & B:
15.6" (39.62cm), 3.2 mm, FHD (1920 *
1080), 16:9 Backlit Panel

Model C:
16.1" (40.89cm), 3.2 mm thick, FHD
(1920 * 1080),16:9 Backlit Panel

Model D:

17.3" (43.94cm), 4.0 mm, FHD (1920 *
1080),16:9 Backlit Panel

Dual Channel DDR4

Two 260 Pin SO-DIMM Sockets
Supporting DDR4 2400 MHz / 2666 MHz
Memory Modules (real operational
frequency depends on the FSB of the
processor)

Memory Expandable up to 32GB
(maximum), Compatible with 4GB/8GB/
16GB Modules

\ o/
RS
SO-DIMM Memory Types
All SO-DIMM memory modules installed in the
system should be identical (the same size and
brand) in order to prevent unexpected system

behavior.

Don’t mix SO-DIMM memory module sizes
and brands in order to prevent system prob-
lems.

One Changeable 2.5" 7mm(h) Hard Disk
Drive (HDD) / Solid State Drive (SSD)
with SATA Interface

One M.2 2280 SSDs with SATA Interface
(Factory Option)
OR

One M.2 2280 SSD with PCle Gen 3 x4
Interface (Factory Option)

One 128Mb SPI Flash ROM
AMI BIOS

High Definition Audio
Built-In Array Microphone
2 Built-In Speakers

Sound Blaster™ Cinema 5

Full Size White LED llluminated
Keyboard with Numeric Pad (Factory
Option)

Full Size Colored RGB LED llluminated
Keyboard with Numeric Pad (Factory
Option)

Built-In TouchPad with Microsoft Multi
Gesture & Scrolling Functionality

LED Indicators - Power/Suspend,
Battery, HDD, Camera, Airplane

One USB 2.0 Port

One Type-A USB 3.0 (USB 3.1 Gen 1) Port
One Type-A USB 3.1 (USB 3.1 Gen 2) Port
One Type-C USB 3.1 (USB 3.1 Gen 2) Port

D - 2 Specifications



*Note: The maximum amount of current supplied
by USB Type-C ports is 500 mA for USB2.0/900
mA for USB 3.1

1 * Mini DisplayPort 1.2

1 * Mini DisplayPort 1.3

One HDMI™ (High-Definition Multimedia
Interface) Out Port (with HDCP)

One Headphone/Speaker-Out Jack

One Microphone-In Jack

One RJ-45 LAN Jack

One DC-In Jack

Embedded Multi-In-1 Push-Push Card
Reader

- MMC / RSMMC

- SD/ Mini SD / SDHC / SDXC

Card Reader Note: Some of the cards

require PC adapters that are usually
supplied with the cards.

Two or Three M.2 Slots:

Slot 1: for M.2 2230 WLAN Combo Module
Card with PCle/USB/CNVi Interfaces (E Key)

Slot 2: for M.2 2280 SSD Card with SATA/
PCle Gen 3 x4 Interface (M Key)

For Models A & B Only:

Slot 3: for M.2 3042 LTE/4AG Module Card
with USB Interface (B Key) - (Factory
Option)

Built-In 10/100/1000Mb Base-TX Ethernet
LAN

Intel® Dual Band Wireless-AC 9260
(2*2 802.11 a/c) WLAN + Bluetooth M.2
2230 Combo Module (Factory Option)

Intel® Dual Band Wireless-AC 9560
(2*2 802.11 a/c) WLAN + Bluetooth M.2
2230 Combo Module (Factory Option)

Intel® Dual Band Wireless-AC 9462
(1*1 802.11 a/c) WLAN + Bluetooth M.2
2230 Combo Module (Factory Option)

Specifications

1.0M HD PC Video Camera Module

2.0M FHD PC Video Camera Module
(Factory Option - For Models A, B & D)

For Models A & B Only:
4G/LTE M.2 3042 Card Module (Factory
Option)

Windows® 10 RS4 (64-bit)

Metal Style

Shipping Mode

Flexicharger

Intel® Optane™

Windows® Mixed Reality Compatible

For Models A, B & D Only:
Microsoft Cortana with Voice Technology

Security (Kensington® Type) Lock Slot
BIOS Password
Intel® PTT for Systems without TPM
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Specifications

Trusted Platform Module 2.0 (Factory
Option)

Fingerprint Reader Module (Factory
Option for some model types)

Supports Wake on LAN (AC Mode Only)
Supports Wake on USB

Supports Wake on RTC Alarm (AC Mode
Only)

Removable 6 Cell Smart Lithium-lon
Battery Pack 62WH (Factory Option)

Removable 6 Cell Smart Lithium-lon
Battery Pack 47WH (Factory Option)

Full Range AC/DC Adapter — AC in 100 -
240V, 50 - 60Hz DC Output 19.5V, 6.15A
(120 Watts)

D - 4 Specifications

Temperature

Operating: 5°C-35°C
Non-Operating: -20°C - 60°C
Relative Humidity

Operating: 20% - 80%
Non-Operating: 10% - 90%

Models A. B & C:

378mm (w) * 267mm (d) * 26.9mm(h)
2.3kg *Barebone System with VGA Card
& Battery

For Model D:

418.5mm (w) * 288.7mm (d) * 27.4mm(h)
2.9kg *Barebone System with VGA Card
& Battery

*A barebone system does not include the HDD, RAM,

adapter, power cord and factory option modules
(weight tolerance within +/- 5%).
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